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General Safety Summary

General Safety Summary
Review the following safety precautions to avoid injury and prevent damage to this product or any
products connected to it.
To avoid potential hazards, use this product only as specified.
Only qualified personnel should perform service procedures.
While using this product, you may need to access other parts of a larger system. Read the safety sections
of the other component manuals for warnings and cautions related to operating the system.

To Avoid Fire or Personal Injury
Connect and disconnect properly. Connect the probe output to the measurement instrument before
connecting the probe to the circuit under test. Connect the probe reference lead to the circuit under test
before connecting the probe input. Disconnect the probe input and the probe reference lead from the circuit
under test before disconnecting the probe from the measurement instrument.
Observe all terminal ratings. To avoid fire or shock hazard, observe all ratings and markings on the product.
Consult the product manual for further ratings information before making connections to the product.
Do not operate without covers. Do not operate this product with covers or panels removed.
Do not operate with suspected failures. If you suspect that there is damage to this product, have it inspected
by qualified service personnel.
Avoid exposed circuitry. Do not touch exposed connections and components when power is present.

Terms in This Manual
These terms may appear in this manual:
WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in damage to this product
or other property.

TekExpress Serial ATA/SAS Automated Solutions
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Using Online Help

Using Online Help
Select Help from the menu to open the help file. You can also find an electronic copy of the help file in the
Documents directory on the 063-4068-XX DVD.
Tables of Contents (TOC) tab – Organizes the Help into book-like sections. Select a book icon to open a
section; select any of the topics listed under the book.
Index tab – Enables you to scroll a list of alphabetical keywords. Select the topic of interest to bring
up the appropriate help page.
Search tab – Allows a text-based search.
Follow these steps:
1. Type the word or phrase you want to find in the search box. If the word or phrase is not found, try the
Index tab.
2. Choose a topic in the lower box, and then select the Display button.

General Help Functions:
Select the Print button from the Help topics menu bar to print a topic.
To return to the previous window, select the Back button.
Use hyperlinks to jump from one topic to another.
If the Back button is grayed out or a jump is not available, choose the Help Topics button to return to
the originating help folder.

Related Documentation
Technical Specification documents
http://www.tek.com/Measurement/applications/serial_data/sata.html
ftp://ftp.iol.unh.edu/pub/sas/test_suite/SAS-2_6Gbps_Physical_Layer_Test_Suite_(v1.00).pdf
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Conventions

Conventions
Online Help uses the following conventions:
The term “SATA” refers to Serial Advanced Technology Attachment.
The term “SAS” refers to Serial Attached SCSI.
The term “DUT” is an abbreviation for Device Under Test.
The term “select” is a generic term that applies to the two mechanical methods of choosing an option:
using a mouse or using the touch screen.
Table 1: Icon descriptions
Icon

Meaning
This icon identifies important information.

This icon identifies conditions or practices that could result in loss of data.
This icon identifies additional information that will help you use the
application more efficiently.
xxx
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Technical Support

Technical Support
Tektronix values your feedback on our products. To help us serve you better, please send us your
suggestions, ideas, or comments on your application or oscilloscope.
When you contact Tektronix Technical Support, please include the following information (be as specific as
possible):

General Information
All instrument model numbers.
Hardware options, if any.
Probes used.
Your name, company, mailing address, phone number, FAX number.
Please indicate if you would like to be contacted by Tektronix about your suggestion or comments.

Application Specific Information
Software version number.
Description of the problem such that technical support can duplicate the problem.
If possible, save the setup files for all the instruments used and the application.
If possible, save the TekExpress setup files, log.xml and status messages text file.
If possible, save the waveform on which you are performing the measurement as a .wfm file.
Forward the information to technical support using one of these methods:
E-mail – techsupport@tektronix.com
FAX – (503) 627-5695

TekExpress Serial ATA/SAS Automated Solutions
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What is New in this Release

What is New in this Release
This version of TekExpress includes the following feature enhancements:
S-Parameters for SATA/SAS (6G)
Compliance needs for receiver UTD1.4
Receiver Margin testing using High Performance Scan and Select Scan Parameter Preset
PHY-TSG-OOB Enhancements for SAS/SATA

Accessories
About the Test Fixture
The TF-SATA-NE-ZP and TF-SATA-FE-ZP test fixtures that facilitate SATA/SAS Compliance testing are
manufactured and distributed by Crescent Heart Software, Inc. For more information, visit the Crescent
Heart Software Web site www.c-h-s.com .
The TF-SATA-TPA-P, TF-SATA-TPA-R, TF-SATA-TPA-PRC and TF-SAS-TPA-P, TF-SAS-TPA-R,
TF-SAS-TPA-PRC test fixtures that facilitate SATA/SAS Compliance testing are manufactured
by Wilder Technologies. For more information, visit the Wilder Technologies Web site
http://www.wilder-tech.com/pdf.htm .
The pin assignments for Wilder and CHS test fixtures are as follows:
Table 2: Pin assignments
Wilder test fixture

CHS test fixture

Drive RP+

HR+

Drive RP–

HR–

Drive TP+

HT+

Drive TP–

HT–

xxx

About Frame Error Analyzer
The Crescent Heart Software SATA II and III probe adapter facilitates Receiver Signalling Group test.
Visit www.c-h-s.com for more information.

About Keithley Switch
The S46 Microwave Switch System is designed to simplify the automated switching needed
to test a wide range of telecommunications products and devices. For more information, visit
http://www.keithley.com/applications/aerospace/?mn=S46 .
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Accessories

About the Power Splitter
The power splitter part number 1580 Divider PWR DC-26.5 GHz is required in certain test configurations
of TekExpress SATA (RSG-RMT, Rx-Tx without RF switch) and SAS. For more information, visit the
Aeroflex/Weinschel Inc Web site www.aeroflex-weinschel.com .

About the Test Adapter
The SAS Plug and Receptacle Test Adapters (SAS-TPA-P and SAS-TPA-R) test SAS interface cables,
hosts, and devices against the SAS specification 2.1.
Click the following links to view sample fixture photos:
SAS Plug Test Adapter (see page 6)
SAS Receptacle Test Adapter (see page 7)
For more information on SAS test fixtures, refer to SAS Test Adapter User Manual provided by Wilder
Technologies.

6
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Minimum System Requirements

Minimum System Requirements
The minimum system requirements for a PC to run TekExpress are as follows:
Table 3: System requirements
Processor

Pentium 4/M or equivalent processor.

Operating System

Windows XP Service Pack 2.

Memory

512 MB of memory.

Hard Disk

Approximately 2 GB of available hard-disk space for the recommended
installation, which includes full TekExpress installation and distributed
components.

Drive

DVD drive

Display

Super VGA resolution or higher video adapter (800x600 minimum video
resolution for small fonts or 1024x768 minimum video resolution for large fonts).
The application is best viewed at 96 dpi display settings 1.

Software

IConnect® and MeasureXtractor™ Signal Integrity TDR and S-parameter
Software (80SICON) Ver 4.0 or above.
Microsoft Excel 2002 or above.
Microsoft Internet Explorer 7.0 SP1 or later.
Microsoft Photo Editor 3.0 or equivalent software for image files viewing.
Adobe Reader 6.0 or equivalent software for viewing portable document
format (PDF) files.

Other Devices

Microsoft compatible mouse or compatible pointing device.
Four USB ports (2 USB ports minimum).
PCI-GPIB or equivalent interface for instrument connectivity 2.

xxx
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If TekExpress is running on an instrument having a video resolution lower than 800x600 (for example, sampling oscilloscope), it is recommended
to connect a secondary monitor and this has to be enabled before launching the application.
If TekExpress is installed on a Tektronix oscilloscope, the virtual GPIB port cannot be used by TekExpress for communicating with oscilloscope
applications.
If external devices like USB-GPIB or equivalent are used for instrument connectivity, ensure that the Talker Listener utility is enabled in the
DPO/DSA oscilloscope’s GPIB menu.
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Application Directories and Usage

Application Directories and Usage
The application directory and associated files are organized as follows:

TekExpress Serial ATA/SAS Automated Solutions
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File Name Extensions

The following table lists the default directory names and their usage:
Table 4: Default directory names and their usage
Directory names

Usage

InstallDir\TekExpress

Contains the TekExpress application and associated
files.

\TekExpress\TekExpress Serial ATA

Contains files specific to TekExpress Serial ATA.

\TekExpress Serial ATA\Compliance Suites

Has compliance specific sequence files. The folders
under this directory represent the devices to be
tested.

\TekExpress Serial ATA\Compliance Suites\SAS

Includes the Drive folder.

\TekExpress Serial ATA\Compliance Suites\SAS\Drive\

Includes the PHY-TSG-OOB and RX-TX folders.
These represent the suites of install tests for the
SAS drive devices.

\TekExpress Serial ATA\Compliance Suites\Serial ATA\

The folders under this are Cable, Drive and Host.

\TekExpress Serial ATA\Compliance Suites\Serial ATA\Cable

Includes the SI folder. This represents the suite of
install tests for SATA cables.

\TekExpress Serial ATA\Compliance Suites\Serial ATA\Drive\
\TekExpress Serial ATA\Compliance Suites\Serial ATA\Host\

Includes the PHY-TSG-OOB, RSG-RMT, and
RX-TX folders. These represent the suites of install
tests for the SATA drive and host devices.

\TekExpress Serial ATA\ACP
\TekExpress Serial ATA\SCP
\TekExpress Serial ATA\ICP

Includes instrument and application specific
interface libraries of TekExpress.

\TekExpress Serial ATA\Data Manager
\TekExpress Serial ATA\Data Storage
\TekExpress Serial ATA\Report Generator

Includes the result management specific libraries of
TekExpress are present in these folders.

\TekExpress Serial ATA\Documents

Includes the Method of Implementation documents
and technical documentation for the application.

\TekExpress Serial ATA\Bin
\TekExpress Serial ATA\Lib
\TekExpress Serial ATA\Tools

Includes the Miscellaneous libraries of TekExpress.

xxx

File Name Extensions
The software uses the following file name extensions:
File name extension

Description

.TekX
.seq

The session file is saved in this format.

.xml

The encrypted XML file that contains the test specific configuration
information. The log file extension is also xml.

.PDF

The PDF file that details the method of implementation for the test.

The test sequence file.

xxx
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How to Activate the License

How to Activate the License
Follow the steps below to activate the license:
1. Click Help > About to view the license information.

2. Click the View Version Details link to check the version numbers of the installed test suites.

3. Click the View End-User License Agreement link to open the following Tektronix Software License
Agreement window. Click Print to print the License Agreement.

TekExpress Serial ATA/SAS Automated Solutions
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How to Activate the License

4. Click License Info to view the available software options. This window shows the license key and the
various options with their status (active or inactive) with the current license key.
5. If you are activating the license for the first time, the license key field is empty. To activate the license,
connect the USB dongle to your computer, enter the license key provided in the license key certificate,
and click Activate. If the activation is successful, a

sign is displayed next to the license key field.

6. If you are reactivating the license, click Reactivate, enter the new license key and click Activate.

12
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Before You Click Run

Before You Click Run
After you first launch TekExpress, it creates the following folders on your computer:
\My Documents\My TekExpress.

NOTE. Ensure that the “My TekExpress” folder has read and write access.
NOTE. If a user with a different Windows login ID launches TekExpress, a new My TekExpress folder is
created under that user’s My Documents folder.
\My Documents\My TekExpress\Serial ATA. Similarly for SAS, the folder is \My
Documents\My TekExpress\SAS.
\My Documents\My TekExpress\Serial ATA\Untitled Session. Every time the
TekExpress SATA.exe is launched a Untitled Session folder is created under Serial ATA
folder. The Untitled Session folder is deleted when you exit TekExpress.

CAUTION. Each session has multiple files associated with it. Do not modify any of the session files and/or
folders as this may result in loss of data or corrupted session files.
The My TekExpress folder is created as a shared folder with share name as <domain><user
ID> My TekExpress (or if the PC is not connected to domain then share name is <Computer
name><user ID> My TekExpress).
The above shared folder is mapped as X: (X drive) on to the PC where TekExpress is running.
NOTE. If X drive is mapped to any other shared folder, TekExpress will display a Warning message
window asking to disconnect the X: drive manually.
Do the following before you click Run:
NOTE. Ensure that the network connectivity is enabled on the PC running the TekExpress.
1. Map (see page 14) the shared My TekExpress folder as X: (X drive) on all the instruments used
in test setup running Microsoft Windows Operating System. This share folder is used to save the
waveform files or any other file transfer operations.
2. Right click on the My TekExpress folder and open the Properties dialog box. Select General tab
and then Advanced. In the Advanced Attributes window, ensure that the option Encrypt contents to
secure data is NOT selected. Click here (see page 15) to view the picture.

TekExpress Serial ATA/SAS Automated Solutions
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Before You Click Run

3. Ensure that the SATA/SAS setup files provided with TekExpress DVD are available on the respective
instruments. For more details, refer to the ReadmeFirst.txt located in the SATA Setup Files
folder on the TekExpress DVD.
4. Ensure that all the required instruments are properly warmed up, Signal Path Compensation (SPC) (see
page 15) is performed, followed by cable deskew.

Mapping My TekExpress folder
To map the My TekExpress folder on the instruments, follow the steps below:
1. Open Windows Explorer.
2. From the Windows Explorer menu, select Tools > Map Network drive.
3. Select the Drive letter as X: (if there is any previous connection on X:, disconnect it first through
Tools > Disconnect Network drive menu of Windows Explorer).
4. In the Folder field, enter remote My TekExpress folder path (for example, \\192.158.97.65\
John’s My TekExpress)
5. You can determine the IP address of the PC where “My TekExpress” folder exists by doing
the following:
Select Start > Run menu on the PC where My TekExpress folder exists.
Enter cmd and click Enter.
At command prompt, type ipconfig.

14
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You can find SPC by following the steps below:
1. On the oscilloscope main menu, click Utilities menu.
2. Click Instrument Calibration option.

TekExpress Serial ATA/SAS Automated Solutions
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TekExpress Application Overview

TekExpress Application Overview
TekExpress is the Tektronix Compliance Test Automation Framework, developed to support current and
future test automation needs. It is a highly modular architecture that enables deploying automated test
solutions for various serial standards in a relatively short time. TekExpress provides a compliance test
automation solution for the Serial ATA Gen 1, Gen 2, and Gen 3 standards.
Options available with TekExpress Serial ATA and SAS are:
PHY/TSG/OOB Test Suite— Includes PHY-TSG-OOB test suite Serial ATA Gen1, Gen2 and Gen3
tests.
PHY/TSG/OOB Test Suite — Includes PHY-TSG-OOB test suite SAS 2.0.
RSG-RMT Test Suite — Offers Phy Receiver Signal Requirements (RSG 1-2-3-5-6) and Receiver
Margin Test (RMT) for SATA Gen1, Gen2, and Gen3
Rx-Tx Test Suite — Includes Rx-Tx test suite for Serial ATA Gen1, Gen 2, and Gen 3 tests.
RMT Test Suite — Offers Receiver Margin Test (RMT) for SAS 2.0.
Rx-Tx Test Suite — Includes Rx-Tx test suite for SAS 2.0.
TekExpress SATA Bundle for the Host and Drive Test Suites.
SI Cable Tests for TekExpress SATA — Includes SI test suite for SATA electrical cable assembly
compliance test.

Key Features
The TekExpress provides the following salient features:
Complete SATA Gen1, Gen2, and Gen3 Test Coverage for Hosts, Drives and Cables.
PHY-TSG-OOB measurement for SAS 2.0.
Rx-Tx measurement for SAS 2.0.
Completely automated single button solution.
Significant Reduction In Testing Time Through Automation.
Performs all (UTD 1.2, UTD 1.3, and UTD 1.4 conformant) SATA MOI required Transmitter,
Receiver, and Channel measurements.
Single and Simple Microsoft Windows XP User Interface for Multi-instrument Testing.
Repeatable and accurate results.
Automatic HTML Report and SATA-IO (MS Excel) Scorecard Generation.
Receiver Margin Testing with High Performance Scan and Select Scan Parameter Preset methods.
Direct Synthesis and Device State Control Eliminates the Need for Multiple Sources.

TekExpress Serial ATA/SAS Automated Solutions
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Starting the Application

Powered by NI TestStand™.
Seamlessly Integrate with High-level TestStand Automation Layer.

Starting the Application
The application uses a USB dongle that contains the license key. This dongle must be present on the PC or
the instrument hosting the TekExpress application.
The application also checks for a file, called Resources.xml, located in My TekExpress folder. If this file
is not found, instrument discovery is performed before launching TekExpress. The Resources.xml file
contains information regarding instruments available on network.
When the application starts, it checks for the appropriate license key. If the valid license key is not present,
the application switches to the “Demo” mode. If the application fails to detect the dongle, it continues
to run in Demo mode.
To start the application, you can do one of the following:
Click Start > Programs > Tektronix > TekExpress > TekExpress Serial ATA & SAS. Other
applications follow similar pattern.
Double-click the icon

on the desktop.

If you have previously saved a session, double-click the session file stored under My
TekExpress\Serial ATA or My TekExpress\SAS.
When the application is launched it displays the splash screen providing launch information. The
application also checks for the presence and validity of the USB dongle.

NOTE. If the application was not terminated properly during the last use, a dialog box asks to recall the
previously unsaved session.

18
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Resizing the Application Window

Resizing the Application Window
To minimize the application, click

on the application title bar. To restore the application to its

previous size, select
To maximize the application, click
title bar.

in the Windows task bar.
. To restore it to previous size, click

on the application

Exiting the Application
To exit the application, do one of the following:
Click File > Exit.
Click

on the application title bar.

Global Controls
The menus and controls that appear outside the individual tabs are called “Global Controls”. These are
used to specify the devices to be tested.

Table 5: Controls and Functions
Control name

Function

DUT

The device ID is specified at the global level and the
information is stored in the default location for all data
files. This field cannot be empty and does not allow these
special characters (.,..,...,\,/:?”<>|*). The maximum length
of characters allowed is 32.
This indicates whether your PC has enough memory to run
and test a measurement, which is typically < 10 Gb.
You will be able to run, pause, resume and stop the tests.

xxx
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File Menu

File Menu
Click File on the application menu bar.

The File menu has the following selections:
Menu

Function

New Session

Starts a default session of TekExpress.

Open Session

Opens a saved session.

Save Session

Saves the session.

Save Session As

Saves a session in a different name.

Recently Recalled Setup

Lists all the recent and previously recalled setup files.

Save Report As

Saves the report in user specified location.

Print Preview Report

Previews the report before printing.

Print Report

Opens the Windows “Print” dialog box.

Exit

Closes the application.

xxx

View Menu
Click View on the application menu bar.

20
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Tools Menu

The View menu has the following selections:
Menu

Function

Log File

Opens the log (log.xml) file in the default viewer.

xxx

Tools Menu
Click Tools on the application menu bar.

The Tools menu has the following selections:
Menu

Function

Instrument Bench (see page 21)

Opens a dialog box showing the list of instruments attached to the test setup.

E-mail Settings (see page 23)

Opens a dialog box showing e-mail setting details.

Debug – Deskew Panel (see page 24)

Opens a control panel that allows to control the RF-switch for debugging and
cable deskew.

xxx

Tools > Instrument Bench
The Instrument Bench window shows the list of VISA and Non-VISA resources found on different
interfaces/connections. It serves two purposes at the launch of TekExpress:
Discovers the connected instruments.
Confirms the instrument connection setup.

TekExpress Serial ATA/SAS Automated Solutions
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Tools Menu

When you click Tools > Instrument Bench, the following dialog box is displayed:

Search Criteria: The various connections on which you can search. Non-VISA Resources are the
instruments that cannot be searched using TekVISA.
Retrieved Instruments: Displays the count and details of instruments that were discovered.
Last Updated: Displays the time when the last time search was performed.
TekVISA Refresh Timeout (Seconds): This time out specifies the maximum time that TekExpress
can wait for TekVISA update.
NOTE. TekExpress uses TekVISA for instrument search. Ensure that TekVISA is running on your system
before you refresh the instrument bench window.
Table 6: Retrieved Resources properties in the Instrument Bench window
Title

Description

Connection

Shows the type of connection with the instrument.

Resource

Shows the name of the resource.

Serial Number

Shows the serial number of the resource.

Options

Shows the options available on the instrument. 1

Resource Address

Shows IP Address/Port number of the resource.

xxx

1
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The option column displays the options that fit in the field. To view complete options on the instrument, move the mouse cursor over the option.
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Table 7: Button controls on Instrument Bench dialog box
Button

Function

Refresh

The application searches on the selected connection for resources. While
searching resources it shows the Instrument Bench discovery window. The
Discovery window shows the connection currently being scanned and the
percentage of task completed.

Close

Closes the dialog box.

xxx

Tools > E-mail Settings
Use the E-mail Settings utility to configure and set the e-mail options. The following fields are mandatory
for receiving e-mail notification from TekExpress:
1. Recipient Email Addresses. For example, User@domain.com.
2. Sender’s Address.
3. SMTP Server address of the Mail server configured at client location.
If any of these fields are left blank, the settings are not saved and e-mail notification will not be sent.

Select the option “E-mail Test Results When Complete or on Error” has to be checked to receive the
e-mail. The attachment list depends on what you have selected while configuring the e-mail setup.
NOTE. Among the e-mail attachments, the Analysis Screenshot is not yet functional.
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Tools > Debug-Deskew Utility
The debug-deskew utility allows you to control the RF-switch state for setup debug purpose with primary
objective to perform a real-time oscilloscope deskew (see page 24) operation for complex wiring path from
the DUT TX terminals to the oscilloscope channels through the RF-switch. Using this utility, you can
set the oscilloscope deskew values that are retained by TekExpress SATA automation script throughout
various testing suites.
To ensure accurate results for two-channel measurements and differential signals acquired on two
channels, it is important to first deskew the oscilloscope channels before you take measurements of
your DUT.

The Debug Deskew Utility has the following functions:
State: Sets the Open/Close state of the RF switch channels.
As per the setup requirement, select the channels on the panel to be closed or opened. The previous
state of the RF switch is overridden by the new state. The current state of the RF Switch is not recalled
when the Debug panel is launched. Click
and the current state as seen on the panel is
applied on the selected RF Switch. The selection shown by LEDs on the RF Switch should be same
as the selection shown on the panel.
Read Deskew/Attenuation Values: Reads the current Deskew values of the real time oscilloscope.
With the selected switch state, you are expected to manually perform the deskew (by removing SMA
cable connection from TX terminals of CHS fixture at DUT and reconnecting them to Fast-edge output
of the oscilloscope). Once the deskew values are set on the oscilloscope, click
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deskew values of all the four channels on the selected real time oscilloscope is read by TekExpress and
are retained during test automation sequencing.
Set Deskew/Attenuation values: Click
to restore the last values of
deskew/attenuation. It is restored to the selected oscilloscope.
NOTE. The address of the instruments are passed to the panel on the current suite selection (as detected
in instrument discovery). For example, in RX-TX and SI test suites, the Real Time Oscilloscope is not
available and so it will not be passed. Only the address of the RF Switch is passed, if detected.
For more information on how to deskew real time oscilloscopes, refer to the section Deskew operation
(see page 97).

Help Menu
Click Help on the application menu bar.

The Help menu has the following selections:
Selection

Description or Function

TekExpress Help

Displays TekExpress Help (F1).

About TekExpress (see page 11)

Displays application details such as software name, version
number and copyright.

Activate License

Displays available software options and also about license
activation.

xxx
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Select the Test(s)
The application tests the following three types of SATA devices and SAS Drive devices for compliance.
Drive
Host
Cable
The Select panel allows you to select tests to configure and run.

This panel provides the following functions:

Select Standard
Select the appropriate standard Serial ATA or SAS.

Select Device
Select the Device type. And the test suite options is automatically updated corresponding to the device
selected.
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Select Test Suite
The application allows you to select a subset of tests to execute. Based on the test suite selected, the
Version drop-down list is populated.

Version
Select the appropriate version. For example, SATA Gen 1–UTD 1.2, SATA Gen 2–UTD 1.3, SATA
Gen 2–UTD 1.4 or SAS 2.0.
NOTE. The SI test suite for cable measurement does not have any versions.
The table has the following two columns:
Select: You can include or exclude any test for analysis.
Test Name: Displays the name of the test.
NOTE. If any of the check box in the Select column is grayed, you cannot make any changes. It implies that
the test is mandatory.
Once you select a row, the following options are available:
Table 8: Select panel buttons
Button

Description
Opens the configuration panel for the selected test.
Opens the PDF of method of implementation (MOI) for the selected test.
Opens the schematic for the selected test. This is useful if you want to
verify the test setup before running the test.
Selects all tests in the table.
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Table 8: Select panel buttons (cont.)
Button

Description
Selects all the SATA-IO required tests in the grid and deselects all
informative tests in the table.
Deselects all tests in the table.

xxx

Configure and Run the Test(s)
Use the Configuration panel to create, view, and edit the parameters associated with the acquisition and the
analysis of the selected test.

You have the following options:
To choose between running the tests in a Compliance or User Defined mode.
To reload compliance mode values.
To change the parameters associated with the configuration of acquisition.
To change the parameters associated with analysis configuration.
To change the test limits in User Defined mode.
The upper half of the Configure panel has general parameters that are common for all the tests under the
selected test suite that are editable. The lower half of the Configure panel has test specific parameters.
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NOTE. If any of the test parameters are grayed, it means that these parameters cannot be modified in
compliance mode. When you switch to user-defined mode, these parameters are editable.
Table 9: Test parameters

30

Parameters to configure

Description

Acquire Parameters

Shows the various parameters
related to acquisition of a selected
test. These parameters can vary
from one test to another such as,
Number of Samples and Record
Length.

Analyze parameters

Shows the various parameters
related to analysis of a selected
test. The Analyze parameters
shows example of Jitter values,
whereas the link points out
JIT3 setup files.

Limits

Applies to a specific test. It shows
the measurement limits using
different types of comparisons.

TekExpress Serial ATA/SAS Automated Solutions

How To

View and Select Connected Instruments
Table 9: Test parameters (cont.)
Parameters to configure

Description

Comments

Specifies a comment up to 256
characters long for the selected
test.

Compliance settings
Restores the compliance settings.
Saves all changes that you made.
Dismisses the dialog box and does
not apply changes.
xxx

Click Run in the Select panel to run the selected tests.
For the SAS standard, the Configuration panel works the same way.

View and Select Connected Instruments
Viewing Connected Instruments
The Tools > Instrument Bench menu item is used to discover connected instruments required for the
tests. The application uses TekVISA to discover the connected instruments. Once the operation is done,
the Instrument Bench dialog box resumes operation and lists the instrument-related details based on the
selected search criteria.
NOTE. When the TekVISA Instrument Manager checks for connected Instruments, the Instrument Bench
dialog box does not respond.
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For example, if you select LAN as the search criteria in the Instrument Bench dialog and click Refresh,
the TekVISA Instrument Manager checks for the instruments availability over LAN and the details of
the instrument are displayed under Retrieved Instruments table.

You can provide the time in the TekVISA Refresh Timeout (Seconds) field, within which if the TekVISA
Instrument Manager does not find the instruments, the TekExpress application resumes the operation.
If you choose Non-VISA resources, all the instruments supported by TekExpress but not communicating
over the VISA layer can be searched.

Selecting Connected Instruments
You can view the instruments connected in the Configuration panel. The upper half of the panel displays
the general parameters for the tests under the selected test suite.
Choose the instruments from the drop-down list as shown in the following figure:
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Select the “Do Not Use” option in the drop-down list for those instruments which are optional.
NOTE. The list of instruments displayed is specific to the selected test suite. It does not show all the
connected instruments.

Use Prerecorded Waveforms for Analysis
From the Acquire tab, you can see unique acquisitions, acquisition parameters, acquisition status, and
prerecorded waveform files of the selected test suite. The Acquire panel is specific to a suite and gets
updated every time the selected test suite is changed. This panel shows the acquisition details for the tests
in the currently selected suite. The tests with the common acquisition parameters are grouped together and
shown as a single acquisition.
NOTE. The acquire panel is disabled when the RSG-RMT test suite is selected. If you want to enable
or disable “Use Pre- Recorded Waveform files”, select a test suite other than RSG-RMT to enable the
acquire panel.
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Column name

Function

Acquisition

Acquisition Name

Test

Name of the tests performing acquisitions. One or more test can perform the
same acquisitions.

Status

Test acquisition status of the running test passed at intervals.

Waveform File(s)

Pre-recorded waveform files of unique acquisitions. You can select waveform
files by selecting browse
on individual cells. This allows you to select any
waveform file using the standard file open window.

xxx

The following Acquire source options are available:
Use Pre-Recorded Waveform files: Enabling or disabling the option shows or hides the waveform
file column in the acquisition table.
When you save a session and then select this option, the DUT ID text box changes to a drop-down list,
in which you can select the DUT ID up to the point where the session was saved. A drop-down box
appears above the Waveform file column, showing the run details, including the date and time of each
run. If you select a run, corresponding data for that run is populated (such as the selected test, the test
configuration settings, and the test summary status).
Acquire Step by Step: Selecting this prompts you at the end of each acquisition before proceeding
to the next one.
Show Acquire Parameters: On enabling this option, the acquisition parameters for each unique
acquisition is displayed in the acquisition table.
When you select “Use Pre-Recorded Waveform Files”, the first column shows the waveform type and the
second column shows the tests that use that waveform type for analysis. The following guidelines help you
determine the correct prerecorded waveform for each test to be performed.
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TIP. Select "Show Acquire Parameters" to verify the acquire parameters that are specified and the
corresponding waveform.
Click the following links to get details on them:
Guidelines for PHY-TSG-OOB test suite waveforms
Each test requires a differential or single-ended waveform. For example, as shown in the following figure,
the Unit Interval measurement requires differential waveforms, and the Rise-fall time measurement
requires single-ended waveforms. Some combinations require both single-ended and differential
waveforms. You need to specify all required waveforms. The waveform file name must contain on the
following keywords: Diff, Pos, or Neg so that TekExpress can identify which waveforms are Differential
(Diff), which are Single-Ended Positive (Pos), and which are Single-Ended Negative (Neg).

Guidelines for Rx-Tx test suite waveforms
Test suites such as Rx-Tx and SI need to have reference waveforms and waveforms with DUT. The
acquire panel allows you to specify only DUT waveforms. The reference waveforms are stored in the
following folder location:
Reference Waveforms
Location: X:\Serial ATA\Sampling Scope\TxRxScopeOperation
Naming Convention: Ref_<Acquire Type>_<Parameter1>_<Parameter2>_<Parameter3>_<Parameter4>_<Parameter5>_<Channel Pattern>.wfm
Example:
1. Ref_MFTP-TDR Common_4000_300_4e-011_1e-011_Even_CH3+CH4.wfm
2. Ref_MFTP-TDR Differential_4000_300_4e-011_1e-011_Even_CH3-CH4.wfm
3. Ref_MFTP-TDR Single Ended_4000_300_4e-011_1e-011_Even_CH3.wfm
4. Ref_TDR Common_4000_300_4e-011_1e-011_Even_CH1+CH2.wfm
5. Ref_TDR Differential_4000_300_4e-011_1e-011_Even_CH1-CH2.wfm
6. Ref_TDR Single Ended_4000_300_4e-011_1e-011_Even_CH1.wfm
DUT waveforms
DUT waveforms need to be specified in TekExpress Acquire panel as described above. The file naming
convention should be as follows:
Naming Convention: <Acquire Type> <Channel Pattern>
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Acquire type and corresponding channel pattern:
Acquire type

Channel pattern

TDR Differential

CH1-CH2

TDR Single Ended

CH1+ CH2

TDR Common

CH1+ CH2

MFTP - TDR Differential

CH3-CH4

MFTP - TDR Single Ended

CH3, CH4

MFTP - TDR Common

CH3+CH4

xxx

Examples:
TDR Differential_CH1-CH2_EUT.wfm
TDR Single Ended_CH1.wfm
User1_TDR Common_CH1+CH2.wfm
MFTP - TDR Differential_CH3-Ch4_Session1.wfm
MFTP - TDR Single Ended_CH4_Jan31.wfm
MFTP - TDR Common_CH3+Ch4.wfm
Guidelines for SI test suite waveforms
As mentioned in the guidelines for Rx-Tx test suite, the SI test suite also needs to have reference
waveforms and waveforms with DUT. The acquire panel allows you to specify only DUT waveforms.
The reference waveforms are stored in the following folder location:
Reference Waveforms
Location: X:\Serial ATA\Sampling Scope\SIScopeOperation
Naming Convention:
Ref/Ref_NoFixture_<Acquire Type>_<Parameter1>_<Parameter2>_<Parameter3>_<Parameter4>_<Parameter5>_<Parameter6>_<Parameter7>_<Parameter_8>_<Channel Pattern>.wfm
Example: Reference without fixture
Ref_NoFixture_TDR Differential_Odd_4000_128_5e-010_7e-011_5.5e-011_80_20_CH1-CH2.wfm
Ref_NoFixture_TDR Single Ended_Even_4000_128_5e-010_7e-011_5.5e-011_80_20_CH1.wfm
Ref_NoFixture_TDT CrossTalk_Odd_4000_128_3e-009_CH3-CH4.wfm
Ref_NoFixture_TDT Differential_Odd_4000_128_3e-009_CH5-CH6.wfm
Ref_NoFixture_TDR Common_Even_4000_128_5e-010_7e-011_5.5e-011_80_20_CH3+CH4.wfm
Example: Reference with fixture
Ref_TDR Common_Even_4000_128_5e-010_7e-011_5.5e-011_80_20_CH1+CH2.wfm
Ref_TDR Differential_Odd_4000_128_5e-010_7e-011_5.5e-011_80_20_CH1-CH2.wfm
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Ref_TDR Single Ended_Even_4000_128_5e-010_7e-011_5.5e-011_80_20_CH4.wfm
DUT waveforms
DUT waveforms need to be specified in the TekExpress acquire panel. The file naming convention
should be as follows:
Naming Convention: <Acquire Type>_<Channel Pattern>
Acquire type and corresponding channel pattern:
Acquire type

Channel pattern

TDR Differential

CH1-CH2, CH3-CH4, CH5-CH6, CH7-CH8

TDR Single Ended

CH1, CH2, CH3, CH4

TDR Common

CH1+CH2, CH3+CH4

TDT Differential

CH5-CH6, CH7-CH8

TDT Crosstalk

CH3-CH4, CH7-CH8

xxx

Examples:
TDR Differential_CH1-CH2_EUT.wfm
TDR Single Ended_CH1.wfm
User1_TDR Common_CH1+CH2.wfm
TDT Differential_CH5-CH6_Session1.wfm
TDT Crosstalk_CH4_Jan31.wfm

View the Progress of Analysis
View the progress of the analysis in the Analyze panel. As the analysis of each test is complete, the
result value is updated.
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Analysis Table
The Analysis table contains the following:
The test name.
The status of the tests that are being run.
The tests that are not yet started are shown with a “To be Started” status. A summarized status of the
currently running test is shown on the Status Messages panel.
The Status Messages window timestamps all runtime messages and displays them. You can do the
following:
Display Status: Enable/Disable status messages.
Auto Scroll: The status messages are scrolled automatically.
Clear All: Clear all status messages in Status Window.
Save Status: Save all status messages in text file. Displays a standard save file window and saves the
status messages in the user specified file.
NOTE. The Status Messages window is dockable and can be resized.
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View the Report
After the analysis, a report is automatically generated and displayed in the report panel. The report shows
the results of the tests, including device information and pass/fail status of each test.
The report displays the Device identification, the date and time that was run, and execution time. Test
information like the Device Type, Version, Execution Time, Compliance Mode (Yes or No), and Overall
Test Result (Pass or Fail), MAC Address (in case of Receiver tests) are shown. Instrument information like
the models, serial numbers, and firmware/software versions are shown. A table displays the Test Name,
Measurement Details, Low, High limit values, Test Result, Analysis Execution time and so on.
The Report View Area contains an HTML version of the report template. You can select any area of the
report and copy it to the clipboard to make it available to other application.
The View Scorecard option opens the report in Microsoft Excel 1.

1

You must load Microsoft Excel 2002 before using the “View Scorecard” option.
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View Test Related Files
All the test related files for currently selected tests are always saved under My Documents\My
TekExpress\Serial ATA\Untitled Session.

When you save a session, it is saved with the session name under the path My Documents\My
TekExpress\Serial ATA\SessionName for future references.

The session that is currently running is stored in the same path as “Untitled” until you save it.
WARNING. Do not save a session named “Untitled” or “Backup” because there are application-specific
files and are deleted when you exit the application.
A session folder can contain results for more than one DUT, and a DUT folder can contain more than one
run data folder marked by date-time stamp as folder name.
Here is an example image of data storage:
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RMT Equipment Setup: Drive
You need the following equipment to set up the application:
Required equipment

Supported model

Signal Source

Tektronix AWG7122B (Option 1, 6, 8) or AWG7102 (Option 1, 6)

Real Time Oscilloscope

Tektronix DPO/DSA72004/B, DPO/DSA71604/B, DPO/DSA71254/B, and
DPO/DSA70804/B
MSO71254, MSO71604, MSO70804 and MSO72004
Scope based Error Detector is supported only on DPO/DSA 70000B and
MSO70000

RF Switch

Keithley S46-6666A (Optional)

Frame Error Analyzer

Crescent Heart Software SATA II and III probe adapter

Test Fixture

Crescent Heart Software Test Fixture TF-SATA-NE-ZP
Wilder Test Fixtures TF-SATA-TPA-P, TF-SATA-TPA-R, and
TF-SATA-TPA-PRC

DUT

A SATA Drive to test

xxx
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RMT Equipment Setup: Drive

Figure-1: Setup diagram for Drive RSG-RMT test suite with Scope based ED

NOTE. Click here for details on pin assignments.
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RMT-03-Gen3 (6.0GB/S) Receiver Margin Test
To run an RMT test on a Drive device, do the following:
1. Select Drive as the Device type, select RSG-RMT test suite and SATA Gen1 as the version.
2. Select RMT-03-Gen3 (6.0GB/S) Receiver Margin Test as the test to run and SATA Gen 1–UTD
1.4 as the version.

3. Click Show Schematic to view the setup diagram for the application.
4. Click Configure to configure the test parameters.

TekExpress Serial ATA/SAS Automated Solutions

43

Application Examples for SATA

RMT-03-Gen3 (6.0GB/S) Receiver Margin Test

5. The default settings are in User Defined Mode. Configure the Analyze parameters, such as the Start
Frequency and End Frequency. Click Save to save the new settings.
NOTE. The Value for the Frame Error Counter should be selected as “Do not use”.
6. Enter the DUT ID in the DUT field of Select panel, and click Run.
7. The progress of the analysis is displayed in the Analyze tab.
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8. View the test result report in the Report panel.

PHY-TSG-OOB Equipment Setup: Drive
You need the following equipment to set up the application:
Required equipment

Supported model

Signal Source

Tektronix AWG7122B (Option 1, 6, 8) or AWG7102 (Option 1, 6)
Tektronix DPO/DSA72004/B, DPO/DSA71604/B, DPO/DSA71254/B,
TDS6154C, and TDS6124C

Real Time Oscilloscope

Tektronix MSO71254, MSO71604, and MSO72004
For Gen1-only testing, the following oscilloscopes are also acceptable:
DPO/DSA70804/B, TDS6804B or MSO70804
RF Switch

Keithley S46-6666A (Optional)

Test Fixture

Crescent Heart Software Test Fixture TF-SATA-NE-ZP
Wilder Test Fixtures TF-SATA-TPA-P, TF-SATA-TPA-R, and
TF-SATA-TPA-PRC

DUT

A SATA Drive to test

xxx
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PHY-TSG-OOB Equipment Setup: Drive

Figure-2: Setup diagram for Drive PHY-TSG-OOB test suite

NOTE. Click here for details on pin assignments.
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PHY01 - Unit Interval Test
To verify that the Unit Interval of the SATA Drive transmitter is within the conformance limit, follow
these steps:
NOTE. The test procedure is same for both drive and host except for a change in the connection diagram.
NOTE. All cables must be deskewed before performing this measurement.
1. Select Drive as the device type.
2. Select the PHY-TSG-OOB as the Test Suite and SATA Gen 1–UTD 1.2 as the version.
3. Select PHY01 - Unit Interval.
4. Enter the DUT ID in the DUT field.
5. If you want to verify the test setup before running the test(s), click Show Schematic.

6. Click Configure to configure the test parameters. Observe that the default settings are in Compliance
mode.
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NOTE. The parameters that are not grayed are editable. To change the instrument related values, select
from the drop-down list for each of the parameters.
7. You can configure any test to help you analyze measurement results. To refer to the Serial ATA
Interoperability Program MOI document for information on how to configure the drive transmitter
tests, click Show MOI in the Select panel.
8. Click Save to save the new settings for the selected test. If you want to restore the default settings,
click Restore.
9. Click Run to run the selected tests.
10. The Acquire panel shows the status of the waveform acquisition.
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11. The status of the tests is displayed in the Analyze panel.

12. After the tests complete, a report is generated and displayed in the Report panel.
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You can save the report using the File > Save Report As option.

TSG02 - Rise-Fall Time Test without RF Switch
To verify that the Rise/Fall time of the SATA Drive transmitter is within the conformance limits, follow
these steps:
NOTE. Refer to schematic (see page 53) for connection diagram without the RF Switch.
NOTE. All cables must be deskewed before performing this measurement.
1. Select Drive as the device type.
2. Select PHY-TSG-OOB as the Test Suite and SATA Gen 1–UTD 1.2 as the version.
3. Enter the DUT ID in the DUT field.
4. Select TSG02 - Rise-Fall Time.
5. If you want to verify the test setup before running the test(s), click Show Schematic.
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TSG02 - Rise-Fall Time Test without RF Switch

6. Click Configure to configure the test parameters. Observe that the default settings are in Compliance
mode.
NOTE. The parameters that are not grayed are editable. To change the instrument related values, select
from the drop-down list for each of the parameters.

7. You can configure any test to help you analyze measurement results. To refer to the Serial ATA
Interoperability Program MOI document for information on how to configure the drive transmitter
tests, click Show MOI in the Select panel.
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8. To run the test without using RF Switch, choose the Do not use option from the drop-down list for
the RF switch parameter in the Configure panel.
9. Click Save to save the new settings for the selected test and click Close.
10. Click Run to run the selected tests.
11. The Acquire panel shows the status of the waveform acquisition.

12. The status of the tests is displayed in the Analyze panel.

13. After the tests complete, a report is generated and displayed in the Report panel.
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TSG02 - Rise-Fall Time Test without RF Switch

Figure-3: Setup diagram for Drive PHY-TSG-OOB test suite without RF Switch
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NOTE. Click here for details on pin assignments.

OOB01 - OOB Signal Detection Threshold Test
To verify that the OOB Signal Detection Threshold of the SATA Drive receiver is within the conformance
limits, follow these steps:
NOTE. All cables must be deskewed before performing this measurement.
1. Select Drive as the device type.
2. Select PHY-TSG-OOB as the Test Suite and SATA Gen 1-UTD 1.2 as the version.
3. Enter the DUT ID in the DUT field.
4. Select the OOB01 - OOB Signal Detection Threshold option.
5. If you want to verify the test setup before running the test(s), click Show Schematic.

6. Click Configure to configure the test parameters. Observe that the default settings are in Compliance
mode.
7. If you want to change the parameters, choose User Defined Mode. The message reports that the
changes made to a test may no longer be compliant.
8. You can configure any test to help you analyze measurement results. To refer to the Serial ATA
Interoperability Program MOI document for information on how to configure the drive receiver tests,
click Show MOI in the Select panel.
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OOB01 - OOB Signal Detection Threshold Test

9. Click Save to save the new settings for the test selected. If you want to restore the default settings,
click Restore.

10. Click Run to run the selected tests.
11. The application automatically switches to the Acquire panel showing the waveform acquisition status.

12. The status of the tests is displayed in the Analyze panel.
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13. After the tests complete, a report is generated and displayed in the Report panel.
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RSG-RMT Equipment Setup: Drive
You need the following equipment to set up the application:
Required equipment

Supported model

Signal Source

Tektronix AWG7122B (Option 1, 6, 8) or AWG7102 (Option 1, 6)

Real Time Oscilloscope

Tektronix DPO/DSA72004/B, DPO/DSA71604/B, DPO/DSA71254/B,
TDS6154C, and TDS6124C
MSO71254, MSO71604, and MSO72004
Scope based Error Detector is supported only on DPO/DSA 70000B and
MSO70000
For Gen1-only testing, the following oscilloscopes are also acceptable:
DPO/DSA70804/B, TDS6804B or MSO70804

RF Switch

Keithley S46-6666A (Optional)

Frame Error Analyzer

Crescent Heart Software SATA II and III probe adapter

Test Fixture

Crescent Heart Software Test Fixture TF-SATA-NE-ZP
Wilder Test Fixtures TF-SATA-TPA-P, TF-SATA-TPA-R, and
TF-SATA-TPA-PRC

DUT

A SATA Drive to test

xxx
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Figure-4: Setup diagram for Drive RSG-RMT test suite with CHS
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RSG-01 - Gen1 (1.5Gb/s) Receiver Signalling Group

NOTE. Click here for details on pin assignments.

RSG-01 - Gen1 (1.5Gb/s) Receiver Signalling Group
To run an RSG test on a SATA Drive to conformance standards defined by SATA-IO Interoperability,
follow these steps:
NOTE. This test is applicable for both Drive and Host devices. The test procedure is the same for both drive
and host except for a change in the connection diagram. Refer to Figure 5 for Host connection diagram.
NOTE. All cables must be deskewed before performing this measurement.
1. Select Drive as the device type.
2. Select RSG-RMT as the Test Suite and SATA Gen 1 as the version.
3. Enter the DUT ID in the DUT field.
4. If you want to verify the test setup before running the test(s), click Show Schematic.
5. Select the RSG01-Gen1 (1.5Gb/s) Receiver Signalling Group option.

6. Click Configure to configure the test parameters. Observe that the default settings are in Compliance
mode.
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7. If you want to change the parameters, choose User Defined Mode. The message reports that the
changes made to a test may no longer be compliant.
8. You can configure any test to help you analyze measurement results. To refer to the Serial ATA
Interoperability Program, MOI document for information on how to configure the drive receiver tests,
click Show MOI in the Select panel.
9. Click Save to save the new settings for the selected test.
10. Click Run to run the selected tests.
The status of the tests is displayed in the Analyze panel.

11. After the tests complete, a report is generated and displayed in the Report panel.
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You can save the report using File > Save Report As option.

RMT- Receiver Margin Test
To run an RMT test on a Drive device, do the following:
1. Select Drive as the Device type, select RSG-RMT test suite and SATA Gen1 as the version.
2. Select RMT-01-Gen1 (1.5Gb/S) Receiver Margin Test as the test to run.
3. Click Show Schematic to view the setup diagram for the application.
NOTE. Refer to the Equipment Setup: Drive section for the setup diagram.
4. For information on how to configure the RMT test parameters, refer to RSG - RMT Method of
Implementation document by clicking Show MOI.

TekExpress Serial ATA/SAS Automated Solutions

61

Application Examples for SATA

RMT- Receiver Margin Test

5. Click Configure to configure the test parameters.
6. The default settings are in User Defined Mode. Configure the Analyze parameters, such as the Start
Frequency and End Frequency. Click Save to save the new settings.

7. Enter the DUT ID in the DUT field of Select panel, and click Run.
8. The progress of the Analysis is displayed in the Analyze tab.
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9. The test result report is displayed in the Report panel.
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RSG-RMT Equipment Setup: Host
You need the following equipment to set up the application:
Required equipment

Supported model

Signal Source

Tektronix AWG7122B (Option 1, 6, 8) or AWG7102 (Option 1, 6)

Real Time Oscilloscope

Tektronix DPO/DSA72004/B, DPO/DSA71604/B, DPO/DSA71254/B, TDS6154C,
and TDS6124C
Tektronix MSO71254, MSO71604, and MSO72004
Scope based Error Detector is supported only on DPO/DSA70000B and
MSO70000
For Gen1-only testing, the following oscilloscopes are also acceptable:
DPO/DSA70804/B, TDS6804B or MSO70804

RF Switch

Keithley S46-6666A (Optional)

Frame Error Analyzer

Crescent Heart Software SATA II and III probe adapter

Test Fixture

Crescent Heart Software Test Fixture TF-SATA-NE-ZP
Wilder Test Fixtures TF-SATA-TPA-P, TF-SATA-TPA-R, and TF-SATA-TPA-PRC

DUT

A SATA Host to test

xxx
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Figure-5: Setup diagram for Host RSG-RMT test suite with CHS
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NOTE. Click here for details on pin assignments.

RSG-02 - Gen2 (3.0Gb/s) Receiver Signalling Group
To run a RSG test on a SATA Host to conformance standards defined by SATA-IO Interoperability,
follow these steps:
NOTE. The test procedure is the same for both drive and host except for a change in the connection
diagram. Refer to Figure 4 for the Drive connection diagram.
NOTE. All cables must be deskewed before performing this measurement.
1. Select Host as the device type.
2. Select RSG-RMT test suite and SATA Gen 2-UTD 1.2 as the version.
3. Enter the DUT ID in the DUT field.
4. If you want to verify the test setup before running the test(s), click Show Schematic.
5. Select the RSG-02 Gen2 (3.0Gb/s) Receiver Signalling Group.

6. Click Configure if you want to configure the test parameters. Observe that the default settings are
in Compliance mode.
7. If you want to change the parameters, choose User Defined Mode.
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RSG-02 - Gen2 (3.0Gb/s) Receiver Signalling Group

8. You can configure any test to help you analyze measurement results. To refer to the Serial ATA
Interoperability Program MOI for information on how to configure the host receiver tests, click
Show MOI in the Select panel.
9. Click Save to save the new settings for the selected test. If you want to restore the default settings,
click Restore.

10. Click Run to run the selected tests. The status of the tests is displayed in the Analyze panel.

11. After the tests run successfully, a report is generated and displayed in the Report panel.
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You can save the report using File > Save Report As menu option.

Rx-Tx Equipment Setup: Drive
Resource

Supported model

Signal Source

Tektronix AWG7122B (Option 1, 6, 8) or AWG7102 (Option 1, 6)

Sampling Oscilloscope

Tektronix CSA/TDS/DSA 8200 with two 80E04/80E10 modules

RF Switch

Keithley S46-6666A (Optional)

Test Fixture

Crescent Heart Software Test Fixture TF-SATA-NE-ZP
Wilder Test Fixtures TF-SATA-TPA-P, TF-SATA-TPA-R, and
TF-SATA-TPA-PRC

SMA Cables

Five pair of matched SMA Cables – 179-4944-00 or equivalent
One SMA cable to connect to trigger input
One SMA barrel adapter

Attenuators

Four 6 dB attenuators

DUT

A SATA Drive to test

xxx
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Rx01 - Pair Differential Impedance test

Figure-6: Setup diagram for Drive RXTX test suite

NOTE. Click here for details on pin assignments.

Rx01 - Pair Differential Impedance test
To verify that the Pair Differential Impedance of the SATA Drive receiver is within the conformance
limits, follow these steps:
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NOTE. This test is applicable for both Drive and Host devices. The test procedure is the same for both drive
and host except for a change in the connection diagram. Refer to Figure 7 for Host connection diagrams.
1. Select Drive as the device type.
2. Select RX-TX as the Test Suite and SATA Gen 1-UTD 1.2 as the version.
3. Enter the DUT ID in the DUT field.
4. If you want to verify the test setup before running the test(s), click Show Schematic.
5. Select Rx-01 – Pair Differential Impedance.

6. Click Configure to configure the test parameters. Observe that the default settings are in Compliance
mode.
NOTE. The parameters that are not grayed are editable. To change the instrument related values, select
from the drop-down list for each of the parameters.
7. You can configure any test to help you analyze measurement results. To refer to the Serial ATA
Interoperability Program document for information on how to configure the drive receiver tests,
click Show MOI in the Select panel.
8. Click Save to save the new settings for the test selected. If you want to restore the default settings,
click Restore.
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9. Click Run to run the selected tests.
10. The Acquire panel shows the waveform acquisition status.

11. The status of the tests is displayed in the Analyze panel.
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Rx-Tx Equipment Setup: Host

12. After the tests complete, a report is generated and displayed in the Report panel.

Rx-Tx Equipment Setup: Host

72

Resource

Supported model

Signal Source

Tektronix AWG7122B (Option 1, 6, 8) or Tektronix AWG7102 (Option 1, 6)

Sampling Oscilloscope

Tektronix CSA/DSA/TDS 8200 with two 80E04/80E10 modules

RF Switch

Keithley S46-6666A (Optional)
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Rx-Tx Equipment Setup: Host
Supported model

Test Fixture

Crescent Heart Software Test Fixture TF-SATA-NE-ZP
Wilder Test Fixtures TF-SATA-TPA-P, TF-SATA-TPA-R, and
TF-SATA-TPA-PRC

SMA Cables

Five pair of matched SMA Cables – 179-4944-00 or equivalent
One SMA cable to connect to trigger input
One SMA barrel adapter

Attenuators

Two 6 dB attenuators

DUT

A SATA Host to test

xxx

Figure-7: Setup diagram for Host RXTX test suite

TekExpress Serial ATA/SAS Automated Solutions

73

Application Examples for SATA

Rx03 - Differential Mode Return Loss

NOTE. Click here for details on pin assignments.

Rx03 - Differential Mode Return Loss
To verify that the Differential Mode Return Loss of the SATA Host receiver is within the conformance
limits, follow these steps:
NOTE. This test is applicable for both Drive and Host devices. The test procedure is identical for both drive
and host except for a change in the connection diagram. Refer to Figure 6 for Drive connection diagrams.
1. Select Host as the device type.
2. Select RX-TX as the Test Suite and SATA Gen 2-UTD 1.2 as the version.
3. Enter the DUT ID in the DUT field.
4. If you want to verify the test setup before running the test(s), click Show Schematic.
5. Select Rx06 - Differential Mode Return Loss.

6. Click Configure to configure the test parameters. Observe that the default settings are in Compliance
mode.
7. If you want to change the parameters, choose User Defined Mode. The message reports that the
changes made to a test may no longer be compliant.
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Rx03 - Differential Mode Return Loss

8. You can configure any test to help you analyze measurement results. To refer to the Serial ATA
Interoperability Program MOI document for information on how to configure the host receiver tests,
click Show MOI in the Select panel.
9. Click Save to save the new settings for the test selected. If you want to restore the default settings,
click Restore.

10. Click Run to run the selected tests.
11. The application automatically switches to the Acquire panel. The status of the waveform acquisition is
displayed in this panel.
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Rx03 - Differential Mode Return Loss

12. The status of the tests is displayed in the Analyze panel.

13. After the tests complete, a report is generated and displayed in the Report panel.

You can save the report using File > Save Report As option.
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SI Equipment Setup
Resource

Supported model

Sampling Oscilloscope

Tektronix CSA/DSA/TDS 8200 with four 80E04/80E10 modules

Test Fixture

Two Crescent Heart Software Fixture TF-SATA-FE-ZP

SMA Cables

Four pairs of matched SMA Cables 179-4944-01 or equivalent
Two SMA barrel adapters

DUT

A SATA Cable to test

xxx

Connect the equipment as shown in the following diagram:

Figure-8: Setup diagram for Cable SI test suite

NOTE. Click here for details on pin assignments.
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SI-02 - Cable Absolute Differential Impedance test on a SATA Cable
To run an SI test on a SATA Cable to conformance standards defined by SATA-IO Interoperability, follow
these steps:
NOTE. This test is applicable only for SATA cables.
1. Select Cable as the device type.
2. Select SI as the Test Suite.
NOTE. There is no test suite version for an SI test.
3. Enter the DUT ID in the DUT field.
4. If you want to verify the test setup before running the test(s), click Show Schematic.
5. Select the SI-02 – Cable Absolute Differential Impedance.

6. Click Configure to configure the test parameters. Observe that the default settings are in Compliance
mode.
7. If you want to change the parameters, choose User Defined Mode. The message reports that the
changes made to a test may no longer be compliant.
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SI-02 - Cable Absolute Differential Impedance test on a SATA Cable

8. You can configure any test to help you analyze measurement results. To refer to the Serial ATA
Interoperability Program MOI document for information on how to configure the cable tests, click
Show MOI in the Select panel.
9. Click Save to save the new settings for the test selected. If you want to restore the default settings,
click Restore.
10. Click Run to run the selected tests.
11. The application automatically switches to the Acquire panel. This shows the status of the waveform
acquisition.
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12. On completion of the acquisition, the application switches to the Analyze panel. This panel shows the
status of the analysis.

13. After the tests run successfully, a report is generated and displayed in the Report panel.

You can save the report using the File > Save Report As option.
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PHY-TSG-OOB Equipment Setup: Drive
You need the following equipment to set up the application:
Required equipment

Supported model

Signal Source

Tektronix AWG7122B (Option 1, 6, 8)
Tektronix DPO/DSA72004/B, DPO/DSA71604/B, DPO/DSA71254/B

Real Time Oscilloscope

MSO71254, MSO71604, and MSO72004
RF Switch

Keithley S46-6666A (Optional)

Test Fixture

Crescent Heart Software Test Fixture TF-SATA-NE-ZP
Wilder Test Fixtures TF-SAS-TPA-P, TF-SAS-TPA-R, and
TF-SAS-TPA-PRC

DUT

A SAS Drive to test

xxx
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PHY-TSG-OOB Equipment Setup: Drive

Figure-9: Setup diagram for Drive PHY-TSG-OOB test suite

NOTE. Click here for details on pin assignments.
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Test 5.2.1-Tx SSC Modulation Type Test
To view the setup diagram for PHY-TSG-OOB test suite, click here (see page 82.).
To verify that the 5.2.1-TX SSC Modulation Type of the SAS Drive transmitter is within the conformance
limit, follow these steps:
NOTE. All cables must be deskewed before performing this measurement.
1. Select Drive as the device type.
2. Select the PHY-TSG-OOB as the Test Suite and SAS 2.0 as the version.
3. Select Test 5.2.1-Tx SSC Modulation Type.
4. Enter the DUT ID in the DUT field.
5. If you want to verify the test setup before running the test(s), click Show Schematic.

6. Click Configure to configure the test parameters. Observe that the default settings are in Compliance
mode.
NOTE. The parameters that are not grayed are editable. To change the instrument related values, select
from the drop-down list for each of the parameters.
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7. You can configure any test to help you analyze measurement results. To refer to the SAS
Interoperability Program MOI document for information on how to configure the drive transmitter
tests, click Show MOI in the Select panel.
8. Click Save to save the new settings for the selected test. If you want to restore the default settings,
click Restore.

9. Click Run to run the selected tests.
10. The Acquire panel shows the status of the waveform acquisition.

11. The status of the tests is displayed in the Analyze panel.
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12. After the tests complete, a report is generated and displayed in the Report panel.

You can save the report using the File > Save Report As option.
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Rx-Tx Equipment Setup: Drive
Resource

Supported model

Signal Source

Tektronix AWG7122B (Option 1, 6, 8)

Sampling Oscilloscope

Tektronix CSA/TDS/DSA 8200 with two 80E04/80E10 modules

RF Switch

Keithley S46-6666A (Optional)

Test Fixture

Crescent Heart Software Test Fixture TF-SATA-NE-ZP
Wilder Test Fixtures TF-SATA-TPA-P, TF-SATA-TPA-R, and
TF-SATA-TPA-PRC

SMA Cables

Five pair of matched SMA Cables – 179-4944-00 or equivalent
One SMA cable to connect to trigger input
One SMA barrel adapter

Attenuators

Four 6 dB attenuators

DUT

A SAS Drive to test

xxx
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Rx-Tx Equipment Setup: Drive

Figure-10: Setup diagram for Drive RXTX test suite

NOTE. Click here for details on pin assignments.
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Test 5.4.2-RX Common-Mode Return Loss (SCC11)
To verify that the Rx Common-Mode Return Loss of the SAS Drive transmitter is within the conformance
limit, follow these steps:
1. Select Drive as the device type.
2. Select RX-TX as the Test Suite and SAS 2.0 as the version.
3. Enter the DUT ID in the DUT field.
4. If you want to verify the test setup before running the test(s), click Show Schematic.
5. Select Test 5.4.2-RX Common-Mode Return Loss (SCC11).

6. Click Configure to configure the test parameters. Observe that the default settings are in Compliance
mode.
NOTE. The parameters that are not grayed are editable. To change the instrument related values, select
from the drop-down list for each of the parameters.
7. You can configure any test to help you analyze measurement results. To refer to the SAS
Interoperability Program document for information on how to configure the drive receiver tests,
click Show MOI in the Select panel.
8. Click Save to save the new settings for the test selected. If you want to restore the default settings,
click Restore.
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9. Click Run to run the selected tests.
10. The Acquire panel shows the waveform acquisition status.

11. The status of the tests is displayed in the Analyze panel.
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12. After the tests complete, a report is generated and displayed in the Report panel.
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RMT Methods
Click any of the following methods for more details:
Linear Pass to Fail
The Linear Pass to Fail method is similar to Receiver Margin Test for Gen1 and Gen2 with a difference
that waveforms are generated during run-time using SerialXpress and are tested in a linear format for a
stipulated time until a failure occurs.
High Performance Scan
High Performance Scan system combines two functional blocks of instrumentation to operate as an
autonomous system capable of determining the precise amount of jitter a receiver can tolerate.
The block diagram shown in Figure 11 is configured to make up a feedback control system, which will
automatically indicate the instrumentation to the precise location of maximum jitter tolerance for error-free
operation and determine the margin value.

Figure-11: Block diagram of High Performance Scan system
The block diagram consists of the following:
Stimulus system
The stimulus system automatically sequences different impaired waveforms, which are monotonically
increasing. An external electrical input is used to drive the selection of these waveforms.
Error detector
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An error detector detects if the DUT has exceeded its receiver tolerance to an impaired (jittered) waveform.
The error detector senses data re-transmission bit or framed data errors and issues an error detect signal
in the form of electric pulses when an error condition is detected.
Device Under Test
A DUT with a receiver/transmitter pair is configured into a loopback state such that the incident received
signal is regenerated and transmitted out the transmitter. For example, a SATA disk drive supports a
loopback mode of operation known as Built In Self Test Loopback (BIST-L).

Operation
The High Performance Scan relies on the automatic self sequencing capability of generator (Tektronix
AWG7000 series with Option 8), which can systematically step from one waveform in a sequence to the
next after a specified time or when the loop count constraint has been satisfied. In a specified configuration,
the generator starts at a low jitter value and steps forward automatically to the next incremental jitter
setting and repeats this process with the observed effect of increasing the jitter on the DUT.
When a sufficiently high jitter level has been reached, the DUT in loopback begins to re-transmit errors.
The Error Detect signal is used as a feedback mechanism to the Stimulus System (AWG), which causes
the signal to adjust the impairment level to just below the point where failure conditions are sensed. The
sequence counter automatically indexes forward to higher levels of impairment while error signals from
the Detector cause the sequencer to back down the jitter levels, until the boundary condition at the device’s
highest error free jitter tolerance is reached. This control system based approach to localizing the error or
no error boundary condition increases the speed of determining the jitter tolerance of a device.
Select Scan Parameter Preset
TekExpress® Serial ATA/SAS application allows users to set a combination of frequency and jitter inputs
while performing Receiver Margin Tests. The values of frequency and jitter can be selected at random
and saved as a .csv file.
Follow the steps below to view, modify, or create a Select Scan Parameter Preset File:
1. Connect the equipment as shown in the schematic. Refer Figure 1.
2. Select Drive as the Device type, select RSG-RMT test suite and SATA Gen3 UTD1.4 as the version.
3. Select RMT for either Gen1, Gen2 or Gen3. For example, RMT-03-Gen3 (6.0Gb/S) Receiver
Margin Test.
4. Enter the DUT ID in the DUT field of the Select panel.
5. Click Configure to configure the test parameters.
6. Click on Analyze tab and choose Select Scan Parameter Preset for the Scan Method.
NOTE. The Receiver Margin Test can only be configured but will not be set to perform a scan if the
Select Scan Parameter Preset option is not selected.
7. Select either the Default Presets or enter values for the Scan Parameter Preset Type by selecting User
Defined Full Scan of Frequency and Amplitude and double-clicking on the option.
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The Default Presets available in the drop-down menu are:
Low Frequency Scan
Mid Frequency Scan
High Frequency Scan
Log Frequency Scan

NOTE. Click here to view the default Customer Jitter Profile values when Low Frequency Scan option
is selected.
8. A Custom Jitter Profile table is displayed. Enter values for Frequency, Start Sj, Stop Sj, and Step Sj.
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9. Click Add to include the values in the Custom Jitter Profile.
10. Click Save and enter a session name. The Scan Parameter Preset File is saved in the default location.
11. Click Recall to recall a previously saved file or a preset.
12. Follow steps 9 through 11 provided in the Receiver Margin Test section to run the test. (see page 94)

Receiver Margin Testing
Use the following procedure to perform Receiver Margin Test using either Linear Pass to Fail, High
Performance Scan - Pass to Fail or Select scan preset file method:
1. Connect the equipment as shown in the schematic. Refer Figure 1.
2. Select Drive orHost as the device type.
3. Select RSG-RMT as the Test Suite and SATA Gen 3 UTD 1.4 as the version.
4. Enter the DUT ID in the DUT field.
5. If you want to verify the test setup before running the test(s), click Show Schematic.
6. Select RMT for either Gen1, Gen2 or Gen3. For example, RMT-03-Gen3 (6.0Gb/S) Receiver
Margin Test.
7. Click Configure to configure the test parameters.
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8. In the Analyze tab, select one of the following scan methods:
Linear Pass to Fail
In this method, the waveforms generated are tested in a linear format for a stipulated time until a
failure occurs.
High Performance Scan - Pass to Fail
In this method, the waveforms generated are tested as in a manner explained in the High
Performance Scan section. The scan parameters are read from the values of Start, Stop, and
Step values of frequency and Sinusoidal jitter (Sj) as selected in the Analyse Parameters tab
in the Configuration Panel.
Select Scan Parameter Preset
In this method, the waveforms generated are tested based on the values defined in the Custom
Jitter Profile. The scan parameters are read from the values of Start, Stop, and Step values of
frequency and Sinusoidal jitter (Sj) as available in the preset file selected. For example, the
values that are shipped along with the application are shown in the following Custom Jitter Profile
table. Waveforms are generated for each set of Frequency, Start Sj, and Stop Sj in steps specified
in the Step Sj field.

9. Select Always create waveform or Use pre-created waveform in theWaveform creation option.
NOTE. Selecting the option Always create waveform results in all the existing waveforms getting recreated
and overwritten in theWaveform Library Location provided. If the Use pre-created waveform option is
selected, only the waveforms and vectors, which are not present are created.
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10. Click Run to run the selected tests.
11. After the tests complete, a report is generated and displayed in the Report panel.
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Deskewing Real Time Oscilloscopes
The following procedure is used for deskewing direct input SMA channels on a real time oscilloscope.
NOTE. This deskew method is applicable for RSG-RMT and PHY-TSG-OOB test suites.
1. Run Signal Path Compensation (SPC) on the oscilloscope.
2. Connect a SMA Power Splitter (preferred) or SMA 50 ohm coaxial “T” connector to the Fast Edge
output of the oscilloscope.
3. Connect SMA cables from each of the two channels to be deskewed to the power splitter (or SMA
coaxial “T” connector). It is best to use matched cables when making high speed serial measurements.
It is important to use the same cables that are used for subsequent measurements.
4. Select Default Setup, and then select Autoset on the oscilloscope front panel.
5. Set the oscilloscope for 70% to 90% full screen amplitude on both channels. Center both traces
so that they overlap.
6. Make sure that volts/div, position, and offset are identical for the two channels being deskewed.
7. Set the time/div to approximately 100 ps/div or less, with sample rate at 1 ps/pt. These settings
are not critical, but should be close.
8. Set the horizontal acquisition mode to average, which provides a more stable display.
9. Select Deskew from the Vertical menu.
10. Verify that the reference channel (typically CH1 or CH2) is set to 0 ps deskew.
11. In the deskew control window, select the channel to deskew (typically CH3 or CH4). Adjust the
deskew to overlay the rising edge as best as possible.
NOTE. Typical values are in the 10’s of ps or less with cables connected directly from Fast Edge to SMA
inputs. If you are using a switch box (for example, Keithley), deskew the complete path from where the
test fixture connects, through the switch, and into the oscilloscope. Deskew values in these cases may
be as much as 30 ps or more.
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There are sometimes significant differences in the skew between two TCA-SMA adapters. If you find
that a system requires a very large correction, it might be better to find a pair of TCA-SMA adapters
that match each other better.

Manual Deskew Procedure for Sampling Oscilloscopes
Mixed Mode TDR Channel Alignment with Independent TDR Source
This deskew procedure uses an independent acquisition source and assumes availability of two TDR
sampling modules (80E04, 80E08, or 80E10). You can also deskew with one TDR (80E04, 80E08, or
80E10), and one dual sampling module (80E03 or 80E09). It aligns both samplers and TDR steps allowing
you to measure mixed mode S-parameters. The procedure starts with the alignment of the samplers and
concludes with alignment of the acquisition channels.
The following equipment is required:
One sampling oscilloscope mainframe (TDS8000, TDS/CSA/DSA8200).
Two TDR sampling modules (80E04, 80E08, or 80E10).
Four matched SMA cables.
One SMA barrel (female-to-female) adaptor. Click here (see page 98) to view the picture.

Equipment required to perform mixed mode deskew procedure. The wrist strap is important for
ESD protection and a calibrated torque wrench is recommended to protect the connectors and to
get good repeatability.
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Click the links below to get details on them.
Align the acquisition channels to the ends of the cables.
The purpose of this step is to set the samplers on each channel so that an input into the open end of each
cable arrives at the sample gate at precisely the same time. This step compensates for cable and sampler
differences. CH1 through CH3 are aligned using CH4 as an independent TDR source. Then, CH4 is
aligned with respect to CH3 using CH1 as the independent source. The following deskew procedure is to
be performed in rho mode (see page 99).
The “rho” can be selected from the TDR menu of the Setups dialog. Follow the below steps to
get to the rho mode:
1. Select the Setups menu from the Oscilloscope main menu.
2. Click the TDR tab.
3. Select ρ option from the drop-down list.

1. Connect SMA cables to the sampling modules of the oscilloscope. For the best results, ensure that
the SMA cables used in the measurements have approximately the same quality and length (matched
within 20 ps).
2. Connect channel 1 and channel 4 with SMA barrel, activate TDR step on channel 4 and acquire using
channel. Click here (see page 100) to see the figure.
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CH1 is connected to CH4 with an SMA barrel. The TDR step is generated on CH4 and acquired
using CH1.
3. Adjust the horizontal position and scale to get the rising edge on screen with good resolution
(20 ps/div). Record length should have a maximum of 4000 points.
4. Save channel one (CH1) waveform as a reference trace. CH2 and CH3 are aligned with respect to it.
5. Connect CH2 to the CH4 using SMA barrel, and display CH2 on the screen.
6. Turn on the delay measurement to measure the time difference between the rising edge on the reference
trace and the rising edge of CH2 as shown here (see page 101).
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Delay measurements between the reference (R1) acquired from the CH1 and the CH2. It has to
be the minimum for the best deskew value.
7. Adjust the channel deskew value in the Vertical menu of the Setups dialog box until a delay value
within 1 ps is achieved.
8. Repeat step 5 through step 7 for the CH3.
9. Once the acquisition of CH1 through CH3 is aligned, use the same method to align CH4. Generate
a new reference by using the step of CH1 and acquiring it on CH3. Connect CH3 to CH1 with the
SMA barrel.
10. Repeat step 5 through step 7 for CH4 using the acquired reference from CH3.
Now, all four acquisition channels have been deskewed within 1 ps.
Match TDR step generators.
The purpose of this step is to adjust the TDR pulses so that they arrive at the ends of the cables at
precisely the same time. The deskew has to be performed separately for odd and even TDR steps when
80E04 modules are used. This section describes only odd mode TDR step deskew. The following deskew
procedure has to be performed in rho mode:
1. Disconnect the SMA barrel and turn on TDR pulses of the appropriate polarity for each channel (CH1
and CH2). Use the differential TDR preset selection to activate odd mode.
2. Adjust the horizontal position and scale so that the pulses are visible on the screen as they arrive at the
ends of the cables. (Use the Average mode and vectored display, and set the time scale to 20 ps/div).
3. Turn on the delay measurement to measure the time difference between the two pulse edges.
4. Adjust the Step Deskew in the TDR menu to minimize the time difference between the CH1 and
CH2 pulses. You might want to use the Fine button to reduce the increment of deskew as shown
here (see page 102).
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Differential TDR step deskew. The channels CH1 and CH2 are aligned within ~300 fs.
5. Repeat step 1 through step 4 for CH3 and CH4, and save the instrument setup.
6. Repeat step 1 through step 5 in even mode if desired.
The instrument should now be set up to accurately make differential or common mode TDR measurements.

Sampling Oscilloscope Deskew during Rx-Tx Testing for Test Setup
without RF Switch
When performing Rx-Tx tests with test setup without RF switch it is essential to use long cables (~6 ft.
or more) from AWG channels connected to the power-splitter connection on CH1 and CH2 of sampling
oscilloscope to avoid the reflection from AWG channels. On similar lines it is also essential to use long
cables from “External Trigger” of sampling oscilloscope connected to the power-splitter connection on
CH4.
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You can verify if there is a reflection from AWG channels during test execution process. The waveform
captured on CH1 during deskew operation might look as follows. The highlighted area is reflection
from AWG channels.

Along with using long cable you may be required to adjust horizontal scale properties from “Config”
panel of the application to remove the reflection outside the capture window. Optimal settings horizontal
scale properties for Rx-Tx are described below:
Horizontal Scale (ps): 50
Horizontal Scale - Deskew (ps): 1000
Horizontal Scale - wide window (ps): 3000
Using a 6-ft long cable and above parameters, following is an example of a correct waveform captured on
CH1 during deskew. Notice that there is no visible reflection captured in the window.
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About Overriding Acquire Parameters
This section is applicable for test suites that require a real time oscilloscope (for example, test suites like
PHY-TSG-OOB or RSG-RMT). The TekExpress application supports various oscilloscope models for
SATA compliance testing and not all the oscilloscope models can support the same acquire parameters
(combination of record length, horizontal scale and resolution). For such test suites, TekExpress allows
you to either “Automatically” apply correct acquire parameters settings or manually specify them.
(This option is available in the “Configure” panel of corresponding test suite with the option name “Set
oscilloscope scale, resolution and sampling rate”). When “automatically” is selected, the application
ignores the acquire parameters you specified. If you need to specify your own acquire parameters, then
you must specify the name “Set oscilloscope scale, resolution and sampling rate” option to “Manually” in
the “Configure” panel of the corresponding test suite.

Acquire parameters with “Automatically” option
This option is applicable for the following oscilloscope models only. If any other oscilloscope model is
found, the application will automatically use the parameters that you specified while executing the test
sequence.
Supported TDS models: TDS6154C, TDS6124C, and TDS6804B
Supported DPO/DSA models: DPO/DSA70804/B, DPO/DSA71254/B, DPO/DSA71604/B, and
DPO/DSA72004/B
Supported MSO models: MSO71254, MSO71604, MSO72004, and MSO70804
For supported oscilloscope models, the following acquire parameters are applied automatically during test
sequence execution depending on the type of acquisition.

TDS6154C, TDS6124C, TDS6804B
Sampling
rate
(Gs/s)

DPO/DSA70804/B, DPO/DSA71254/B,
DPO/DSA71604/B, DPO/DSA72004/B
MSO71254, MSO71604, MSO72004,
MSO70804
Scale
(μs/div)

Resolution
(ps/pt)

25

10

20

4

25

4

20

Initial OOB
validation

2

100

2

80

HFTP *

40

25

40

40

HFTP-Gen 1

10

50

10

40

HFTP-Gen 2

4

25

4

20

HFTP-Gen 3

NA

NA

40

40

Scale
(μs/div)

Resolution
(ps/pt)

BISTL validation
for RSG/RMT

10

BISTL validation
for PHY/TSG

Acquisition type
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DPO/DSA70804/B, DPO/DSA71254/B,
DPO/DSA71604/B, DPO/DSA72004/B
MSO71254, MSO71604, MSO72004,
MSO70804

TDS6154C, TDS6124C, TDS6804B
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Resolution
(ps/pt)

Sampling
rate
(Gs/s)

Acquisition type

Scale
(μs/div)

Scale
(μs/div)

Resolution
(ps/pt)

Sampling
rate

HFTP-Gen 3

NA

NA

4

20

LBP-Gen 1

10

50

10

40

LBP-Gen 2

4

25

4

20

LBP-Gen 3

NA

NA

10

20

LBP-Gen 3

NA

NA

4

20

LFTP-Gen 1

10

50

10

40

LFTP-Gen 2

4

25

4

20

LFTP-Gen 3

NA

NA

0.0003

20

LFTP-Gen 3

NA

NA

4

20

MFTP-Gen 1

10

50

10

40

MFTP-Gen 2

4

25

4

20

MFTP-Gen 3

NA

NA

10

20

MFTP-Gen 3

NA

NA

0.0001

20

MFTP-Gen 3

NA

NA

4

20

COMINIT and
COMWAKE

10

50

20

10

40

25

COMINIT
INSPEC LL

200

800

1.25

200

800

1.25

COMINIT
INSPEC UL

200

800

1.25

200

800

1.25

COMINIT
INSPEC UL

200

800

1.25

200

800

1.25

COMINIT
OUTOFSPEC
LL

200

800

1.25

200

800

1.25

COMINIT
OUTOFSPEC
UL

200

800

1.25

200

800

1.25

200
COMINIT/COMRESET/COMWAKE-No
response

800

1.25

200

800

1.25

COMINIT/COMRESET/COMWAKEResponse

200

800

1.25

200

800

1.25

COMWAKE
INSPEC LL

200

800

1.25

200

800

1.25
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TDS6154C, TDS6124C, TDS6804B

DPO/DSA70804/B, DPO/DSA71254/B,
DPO/DSA71604/B, DPO/DSA72004/B
MSO71254, MSO71604, MSO72004,
MSO70804

Scale
(μs/div)

Resolution
(ps/pt)

Sampling
rate
(Gs/s)

Scale
(μs/div)

Resolution
(ps/pt)

Sampling
rate

COMWAKE
OUTOFSPEC
LL

200

800

1.25

200

800

1.25

COMWAKE
OUTOFSPEC
UL

200

800

1.25

200

800

1.25

COMRESET

4

50

20

4

40

25

COMWAKE

10

50

20

10

40

25

Acquisition type

xxx

*

Long record length for Gen1 SSC and Gen2 SSC

Acquire Parameters with “Manually” Option
It is important that you carefully specify the correct combination of horizontal scale and resolution
depending on the oscilloscope model. If an incorrect combination of horizontal scale and resolution is
specified, then the test execution sequence is terminated, displaying incorrect parameter set status message.
An example of status message is as shown:
10/3/2007 10:29 AM::Writing command-HORIZONTAL:RECO 2500000
10/3/2007 10:29 AM::Set record length to-2000000

The following procedure describes how to manually identify a working combination of horizontal scale,
resolution and record length for a given oscilloscope:
1. Open the Talker Listener utility of the TekVISA on the oscilloscope.
2. default settings on the oscilloscope by clicking Default setup on the oscilloscope front panel.
3. Use the oscilloscope front panel to disable CH1 and enable CH2 and CH4.
4. In the Talker Listener utility, enter HORI:RECO <record length> (for example, HORI:RECO
2000000) and click Write.
5. Verify that the oscilloscope has applied the record length that you specified in step 4. If yes, continue
with step 6 else repeat steps 2 through 4 with another record length.
6. In the Talker Listener utility, enter HORI:SCALE <horizontal scale> (for example, HORI:SCALE
10E-06) and click Write.
7. Verify that the oscilloscope has applied the horizontal scale that you specified in step 6 and also verify
that the record length set in step 4 is not changed. If this condition is met, then you have identified a
working combination of Acquire parameters. If this condition is not met, then repeat steps 2 through 6
with another combination of Acquire parameters.
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The above step will help identify the correct combination of horizontal scale and record length. To find
combination of horizontal scale and resolution, follow the preceding procedure and find the resolution
using the following mathematical expression.
Resolution = (10 * horizontal scale)/Record length
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Using the Pattern Generation Utility to Test Receivers
The Pattern Generation is a utility that generates a controlled jittered waveform for performing the RSG
(Receiver Signal Gain) and RMT (Receiver Margin Testing) testing for the DUT receiver. This utility uses
a direct synthesis approach where required amounts of jitter components are added to the frame composite.
These patterns are injected to DUT using the Arbitrary Waveform Generator 7000 series with option 6,
Test fixture and matched pair cables.
NOTE. You can use Tektronix SerialXpress Pattern Generation utility for Gen3 UTD 1.4 version for
all generations/speeds.
Use the Calibration process (as outlined in the RSG MOI, section APPENDIX C - Measurement
Calibration) to calibrate and obtain the calibrated values of Random Jitter, Periodic Jitter, ISI jitter,
amplitude level, (optimal amplitude value of) jittered frequency (which is tuned to meet the nominal Total
Jitter specified); use these calibrated values for the pattern generation utility.
It is recommended to do the calibration process for each pattern generation of interest.
For the RMT tests, there is a need to test the DUT over a range of frequencies. The calibration has to be
carried out at these frequencies for exact results.
The pattern generation utility is located in the following folder of TekExpress install DVD:
<DVD Drive letter>:\SATA Setup Files\AWG Files\SataPatternGeneration Utility

If you have installed AWG setup files, the same utility will also be available on the AWG local hard-drive
in the following folder location:
C:\SataPatternGenerationUtility\

Important Notes:
Above folder contains Ver 3.0 of the pattern generation utility. Ver 3.0 is updated with feature to
characterize ISI jitter insertion.
The MATLAB Run-time engine 7.6 is required for executing these utility files. MATLAB
Run-time engine 7.6 installer is located on TekExpress install DVD in, <DVD drive
letter>:\Software\MATLAB_Runtime folder.
The file attribute for Serial ATA pattern generation utility and associated files should NOT be “Read
only”. It is noticed that upon installation from DVD the file attributes are set to “Read-only” which
causes this utility to terminate prematurely.
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Inputs to the Pattern Generation Utility (ver 3.0 satagen V3.exe) with ISI Jitter characterization
The Pattern Generation Utility Ver 3.0 is an Executable and requires you to input the following parameters
(in this order). You need to provide the following inputs, which are not default values.
1. UTD version. The UTD version should be either 1.2, 1.3 or 1.4 as input.
2. Seconds command line input parameter is the path and name of the Frame composite pattern.
The available options are Gen18KRJTPAT.txt for Gen-1 interface speed and Gen21KRJTPAT.txt,
Gen29KRJTPAT.txt and Gen216KRJTPAT.txt for Gen-2 interface speed. You can also specify
customized text file for frame composite pattern. (For example, frame composite pattern files used in
Ver 1.0 IW4Gen1R10FCP2AnewLBP.txt for Gen1 and IW4Gen2R8FCP2AnewLBP.txt for Gen2
can also be specified).
3. The interface speed of the DUT, the input parameter should be either Gen1 or Gen2.
4. Calibrated voltage swing for the utility. This is usually calculated using the 6 db attenuators at the
end of the match cables. You can refer the amplitude calibration process to measure calibrated
amplitude level.
5. The calibrated Random Jitter (Rj). You can refer to the calibration procedure for more details on how
to calculate the Rj value for this setup. Rj has to specified in ps RMS.
6. Periodic Jitter (Pj) component as frequency in Hz. You should specify the frequency value between
0 to 300 MHz as ‘Start’ and ‘Stop’. The start should be less than the stop otherwise the utility
shows an error.
7. The Pj increment is in steps of 1 MHz (step given as “xxe6”) and the higher range is 300 MHz.
8. The Total jitter (Tj specified in Unit Interval (UI)) range is 0 to 1.2 UI. You have to specify the start
and stop separately as ‘Start’ and ‘Stop’ without the ‘UI’ unit. The start should be less than the stop
otherwise the utility will show an error.
9. The Tj increment values. These values increase in the following steps as per the Serial ATA standard.
The predefined steps are 0.01, 0.02, 0.03, 0.05 and 0.1.
10. The Amplitude Periodic jitter. You have to make sure that the amplitude periodic jitter used in
the utility to generate pattern of interest (for example 10 MHz 0.45 UI) has to result in nominal
Tj value 0.45 UI. This is done by means of trial and error by recording the Tj at the output of the
JIT3 Analysis-Advanced software. Please refer to the MOI calibration procedure for more details.
The following parameters are optional in Ver 2.0 of Pattern Generation Utility; if you are not
specifying these parameters then specify empty arguments (“”, “”).
11. Cable S-Parameter file location is the next command line input parameter. The available options are
9in ISITrace.s4p, 6pt75inISITrace.s4p, 5inISITrace.s4p, 31inISITrace.s4p, 2pt42inISITrace.s4p,
24inISITrace.s4p, 17inISITrace.s4p, 12inISITrace.s4p. You can also specify customized S-Parameter
file created in S4P file format.
12. The last command line input parameter is the cable effect co-efficient. This parameter is used to
specify the multiplying factor for cable S-Parameter. For example, if you specify 1.6 as the cable effect
co-efficient then the cable length effect is considered as 1.6 times. This parameter value is valid only
when the S-Parameter file location is specified.
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Output from the Pattern Generation Utility
The generated jittered waveform is available in the Frame composite pattern file path with file name as
<UTD version>_<Jitter Frequency>-MHz-TJ>UI.wfm. <Example for UTD version 1.2, Pj from 100 MHz
to 105 MHz and Tj= 0.45 UI: The sample file name output format is 1.2_100-MHz-0.45UI.wfm. The five
AWG patterns are generated from 100 MHz to 105 MHz.

Batch file usage
To help you get familiar with the Serial ATA Pattern Generation Utility, an example Example_02.bat file
is provided in the same location as that of utility files.
To use the batch file example, follow these steps:
1. Double-click the Example_02.bat file.
2. The batch file gets launched and you can observe the input parameters on the DOS command prompt
that is taken by the utility.

Calibration Procedure
To generate jittered waveforms for RSG test, the complete calibration procedure has to be followed.
Whereas, to generate jittered patterns for RMT test, only Random jitter calibration is required. Calibration
can be carried out using the JIT3 Analysis - Advanced software.
Click any of the following jitter-related measurements to see its definition:
Random Jitter Calibration
A reference Gen1 and Gen2 MFTP waveform with zero jitter (MFTP-Rj-Cal.wfm) is provided at
c:\SataPatternGenerationUtility\Gen1MFTP folder to verify the calibration of Random jitter
(Rj). Before verifying the Rj calibration, perform an SPC calibration on the Tektronix oscilloscope hosting
the Advanced JIT3 Analysis software and perform a D/A channel calibration on the Arbitrary Waveform
Generator (AWG) to compensate for the instrument’s environmental conditions.
Rj is specified to be 0.18 UI PtP @ 7 Sigma or 4.285 ps RMS for Gen2 signaling rates and correspondingly
8.57 ps for Gen1 signaling rates.
NOTE. The Rj found in the Tektronix AWG MFTP pattern has been digitally synthesized and is a truncated
Gaussian distribution with the 4.7 Sigma crest factor.
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As illustrated in the red circled area of the preceding figure, ensure that the averaged RJ is nominally
reading 4.285 ps RMS ± 4% allowable variation 4.11 ps < Nominal Value < 4.45 ps. Analyze 16E6
contiguous points per measurement, and 3 runs will typically converge on an averaged RJ close to
4.285 ps. For Gen1 rates the nominal variation of Rj is within 8.22 < Nominal Tj Value < 8.9. Jitter
magnitudes in excess of these values should result in recalibration of the AWG.
If the measured value in JIT3 results does not match with nominal Rj value 4.285 ps ±4% then random
jitter component has to be varied as the input to the utility.
Perform this iteration until Rj value is close enough to nominal value specified.
Tj Calibration
Run the Pattern Generation utility using the IW4Gen1R10FCP2AnewLBP.txt for Gen1 and
IW4Gen2R8FCP2AnewLBP.txt for Gen2 text patterns available at c:\SataPatternGenerationUtility\. With calibrated random jitter value and optimal value of the Amplitude of jittered frequency,
generate a XX-MHz -0.45UI.wfm waveform. Analyze this waveform using JIT3 Advanced software.

Observe the averaged Total @ BER (Pk-Pk) Jitter value after three acquisitions. Adjust the amplitude of
jittered frequency value input so as to get the nominal value of Tj. The nominal accuracy of a calibrated
system will provide 0.45 UI Tj conformance within 4% of nominal error. The observed jitter for
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Gen2 signaling Tj should nominally be 149.9 ps of Tj ± 4% allowable variation. 144 ps < Nominal Tj
Value < 155.8 ps. Jitter magnitudes in excess of these values should result in recalibration of the AWG.
For Gen1 rates, the nominal variation of a nominal value of Tj is within 288 < Nominal Tj Value < 312 ps.
If the measured value in the JIT3 results does not match with nominal Tj value 144 ps < Nominal Tj Value
< 155.8 ps then vary the amplitude of the periodic jitter component as the input to the utility.
Perform this iteration until the Tj value is close enough to the nominal specified.
Amplitude Calibration
Signal amplitude conformance requires that Gen1 and Gen2 signaling not exceed 600 mV or 750 mV ptp
and be within 5% of a target minimum amplitude of 325 mV and 275 mV respectively. Fine adjustment
may be performed by adjusting the Vertical amplitude setting on the AWG’s CH1 output. The minimum
amplitude measurements are performed on both 212141 (negative pulse) and 413 (positive pulse) RL
patterns.
Refer to the SATA specifications (Serial ATA Revision 2.5 27-October-2005) on LBP based amplitude
measurements.
The minimum amplitude over a 1 UI epoch is the two consecutive bits at the string of a four or more
consecutive bits, which is not a representative LBP pattern but is the minimum value in Framed Composite
(Pre-ECN18) pattern.
A 0.45 UI to 0.55 UI Histogram is setup on the two lone bits of interest from which the difference of the
mean values is computed to obtain the lone pulse amplitudes.
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Transition Time Validation
Make sure the Rise and Fall time is in the nominal range of < 100 ps. This can be verified using the JIT3
application with same setup files used for Jitter calibration/validation. Rise and Fall time measurements
allow you to validate that the transition rate does not exceed 100 ps 20/80.

After the completion of calibration process, Calibrated Voltage swing required in the jittered waveform,
Calibrated Random Jitter, Optimal value for Amplitude of jittered frequency are available and can be used
for generating waveforms for RSG and RMT tests.
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Setting User Option for SATA DUT Power Cycle Method
TekExpress SATA offers three methods that you can choose from for power cycle operation of SATA
DUTs during the test sequence. You also have an option to fully customize the DUT power cycle operation
automation sequence. Following are the options for defining the SATA DUT power cycle method:
Manual Power Cycle
Power Cycle using AWG DC output to control AT/ATX power supply (default setting)
User specified TestStand sequence
For more details on how to use and configure these options, refer to the DUT-PowerCycle.txt (see
page 115) file located under ICP folder of TekExpress installed folder location.
# =====================
# Note: Read and use this file very carefully.
# Lines with # prefix are considered comments.
# This file defines the way SATA DUT Power Cycle operation is performed during test automation.
# The first line in this TXT file that does not have # character defines the SATA DUT Power Cycle
operation.
# This line should contain one of following keywords (without quotes).
# "Manual", "AWG", "User Defined GPIB", "User Defined TestStand Steps".
# If anything other than above valid keyword is found then Manual method overrides.
# "Manual" : This assumes manual operation of power cycle.
# "AWG" : This assumes AT/ATX power supply is controlled through DC output of AWG.
# Connect Channel-1 of DC output to pin #14 (and pin #15 to GND) in case of 20 pin Molex
connector of AT/ATX power supply.
# Connect Channel-1 of DC output to pin #16 (and pin #17 to GND) in case of 24 pin Molex
connector of AT/ATX power supply.
# "User Defined GPIB" : This assumes a user defined sets of GPIB commands are defined.
# in lines following the valid keyword "User Defined GPIB". (This feature is not active).
# "User Defined TestStand Steps" : This assumes the power cycle steps are defined in
"UserDefinedTurnOFF" & "UserDefinedTurnON" sequence of "ICP_DUT-PowerSupply.seq" file.
# ====================
AWG
Delete this line and start GPIB commands from here onwards, each line assumed to be one command,
you need to take care of complete sequencing from VI_open till VI_close.
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About JTF Calibration and Verification
In an effort to get better correlation between different jitter measurement systems, the SATA PHY
group has defined a standard jitter transfer function requirement which all jitter measurement systems
must meet. This is detailed in ECN-008. The following procedure describes the process for performing
the Jitter Transfer Function calibration. This calibration must be done once prior to making TSG-09
through TSG-12.
The response to jitter of the Jitter Measurement Device (JMD) (the reference clock is part of the JMD) is
measured with three different jitter modulation frequencies corresponding to the following three cases:
SSC (full tracking)
Jitter (no tracking)
The boundary between SSC and jitter
The jitter source is independently verified by separate means. This ensures that the jitter response of the
JMD is reproducible across different test setups.
The three test signals are:
A 750 MHz ± 0.035% sine or square wave with a sinusoidal phase modulation of 20.8 ns ± 10%
peak to peak at 30 kHz ± 1%.
A 750 MHz sine or square wave with a sinusoidal phase modulation of 100 ps ± 10% peak to peak at
50 MHz ± 1%.
A 750 MHz sine or square wave with a sinusoidal phase modulation of 100 ps ± 10% peak to peak at
50 MHz ± 1%.
The independent separate means of verification of the test signals is a time interval error plot on a real
time oscilloscope.
The test procedure checks two conditions: the JTF attenuation and the JTF bandwidth. Care is taken to
minimize the number of absolute measurements taken, making most relative; this reduces the dependencies
and improves accuracy.
Click the following links to view the basic and detailed procedures:
Basic Procedure
Procedure in detail
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Basic Procedure
The basic procedure to perform Jitter transfer function calibration is as follows:
1. Adjust the pattern generator for a D24.3 pattern (00110011) (Gen2 is a 750 MHz sine wave) and
modulation to produce a 30 KHz ±1%, 20.8 ns p-p ±10% sinusoidal phase modulation.
2. Verify the level of modulation meets the requirements and record the p-p level (DJ t). This is done
with a Time Interval Error (TIE) type measurement or equivalent.
3. test signal to the JMD. Turn on the sinusoidal phase modulation. Record the reported DJ.
4. Turn off the sinusoidal phase modulation. Record the reported residual DJ.
5. Calculate and record the level of applied DJ by subtracting the DJ with modulation off from DJ
with modulation on.
6. Calculate the jitter attenuation by 20 × log(DJm/DJt). This value must fall within the range of –72 dB
± 3 dB. Adjust the JMD settings to match this requirement.
7. Adjust the pattern generator for a D24.3 pattern (00110011) (Gen2 is a 750 MHz sine wave) and
modulation to produce a 50 MHz ±1%, 0.3 UI p-p ±10% (100 ps) sinusoidal phase modulation.
8. Verify the level of modulation meets the requirements and record the p-p level (DJ t). This is done
with a Time Interval Error (TIE) type measurement or equivalent.
9. the test signal to the JMD. Record the level as the reference DJ value (DJ 0dB).
10. Calculate the -3 dB value: DJ-3 dB = DJ0 dB × 10(-3/20)
11. Adjust the frequency of the DJ source to 2.1 MHz. Shift the frequency of the PJ source until the
reported DJ difference between PJ on versus PJ off is equal to (DJ -3 dB). The PJ frequency is the
-3 dB BW of the JTF.
12. Adjust the JMD settings to bring the PJ -3 dB frequency to 2.1 MHz ± 1 MHz. Repeat step 4 through
step 12 until both the jitter attenuation and 3 dB frequency are in the acceptable ranges.
13. Check the peaking of the JTF. Adjust the pattern generator for a D24.3 pattern and modulation to
produce sinusoidal phase modulation at the -3 dB frequency and 0.3 UI p-p ± 10% (100 ps). Increase
the frequency of the modulation to find a maximum jitter; it is not necessary to increase beyond
20 MHz. Record the maximum jitter value and frequency.
14. Calculate the JTF Peaking value: 20 × log(DJpkng/DJ0dB). Record this value.

Detailed Procedure
Required Equipment
Tektronix AWG7102 with Opt 6 and Tektronix AWG7122B Opt 8
JTF Waveform Library for Tektronix AWG7000 series
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Test cables
DSA72004 Digital Phosphor Oscilloscope 20 GHz, 50 G/s, or desired BW
JIT3 software and associated JTF setup files
Follow these steps to do the Jitter transfer function calibration:
Step 1
Adjust the pattern generator for a D24.3 pattern (00110011)(MFTP) (Gen2 is a 750 MHz sine wave)
and modulation to produce a 30 KHz ± 1%, 20.8 ns p-p ± 10% sinusoidal phase modulation. To do
this on the AWG7102, open the waveform file “SATA Gen2 30k 62_5Sj.awg”. This will set all
the parameters of the AWG.
a. Connect the AWG to the oscilloscope, using the same matched cable set that is connected to
the oscilloscope during normal jitter measurements. Verify that the cables are connected
to the AWG Interleaved outputs.
b. Select the “Gen2 30kHz 62_5sj” waveform from the Waveform List on the left side of the
display. Drag this to the Waveform display window, and drop in the CH1 area. When the
pop-up appears, choose “Set Waveform”.
c. Set the AWG output to “On”. This will apply the MFTP pattern containing a 30 kHz
modulation with 20.8 ns of jitter to the oscilloscope.

Step 2
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Verify that the level of modulation meets the requirements and record the p-p level (DJ t). This is done
with a Time Interval Error (TIE) type measurement or equivalent.
a. Launch the Jitter Analysis (TDSJIT3) application under the Analyze menu on the oscilloscope.
b. Recall the JIT3 settings file “JTF JIT3 Gen2 setup.ini”. This will set up the oscilloscope
channels as well as the JIT3 settings. It will set up all needed measurements within JIT3.
Reference levels is set automatically when the measurement is run. Click the “TIE RjDj-BER”
tab, and then click “Data TIE 1”. Click “Single” to run the measurement.

JIT3 produces a measurement for Dj in the statistics table, however this value cannot be used directly.
The setup file has automatically created several plots. Click the “Select View” button on the right side
of the screen, and select the Data TIE1 Trend Plot. The resulting plot of a sine wave pattern may have
a long slope which is due to offset values (initial conditions) which are integrated. The peak-to-peak
value of the sinusoidal wave is of importance as this is the level of phase modulation. The long slope
needs to be removed from the plot to find the accurate peak to peak phase modulation. To do this, use
the cursors to take the average of two peaks vs one valley, thus eliminating the long slope.
Choose two adjacent peaks and the valley between to make the measurement. Place horizontal cursors
on the trend plot, and position the cursors to the top of the first peak and the valley. Record the
measured delta.

120

TekExpress Serial ATA/SAS Automated Solutions

Calibration and Verification of Jitter Measurement Devices

Detailed Procedure

Next, move the top cursor to the second peak, and again record the measured delta.

In this example, peak 1 is 21.94 ns, and peak 2 is 19.81 ns. The valley is the reference value.
Determine the slope corrected Dj value: (21.94+19.81)/2 = 20.88 ns. This verifies the level of phase
modulation required. This measured value from the TIE agrees with the level set in the source. Record
this value in the B7 cell of the JTF Calibration spreadsheet.
Step 3
test signal to the JMD.
To make the JMD measurement on the 30 kHz modulated signal, simply click the Data PLL TIE
1 measurement in the JIT3 measurement list. It is not necessary to click the “Single” button to acquire
another waveform, as the measurement was made on the last waveform acquired.

Record this measured value in the B8 cell of the JTF Calibration spreadsheet.
Step 4
Measure the residual jitter by turning off the 30 kHz modulation, and making another jitter
measurement. On the AWG, drag the “Gen2 No Jitter” waveform from the waveform list to the
waveform display area, and drop in CH1. When the pop-up window appears, select “Set Waveform”.
Turn the AWG Ch1 output on.
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On the oscilloscope, click the “Single” button to make another acquisition.

Record this measurement in the B9 cell of JTF Calibration spreadsheet.
The spreadsheet now has enough data to calculate the attenuation level of the JMD.
Step 5
The spreadsheet calculates the level of applied DJ by subtracting the DJ with modulation off from DJ
with modulation on.
(For example, 6.1387 ps - 2.1668 ps = 3.9719 ps)
Step 6
Calculate the jitter attenuation by 20 × log(DJm/DJt). This value must fall within the range of
–72 dB ± 3 dB. Adjust the JMD loop bandwidth setting under the Clock Recovery setup to meet this
requirement. (For example, 20 × log(3.9719 ps/20.83 ns) = 74.41 dB)

If the calculated attenuation is below -72 dB, decrease the loop bandwidth setting, and repeat the
process from step 1 to 6 until the required attenuation is attained. Once the proper loop bandwidth has
been determined, leave this value set for all subsequent measurements.
Step 7
Adjust the pattern generator for a D24.3 pattern (00110011) (Gen2 is a 750 MHz sine wave) and
modulation to produce a 50 MHz ±1%, 0.3 UI p-p ± 10% (100 ps for Gen2) sinusoidal phase
modulation. To do this on the AWG7102, open the waveform file “SATA Gen2 JTF 3db set.awg”.
This will set all parameters of the AWG. This setup file includes a collection of waveforms that can be
used to verify the -3 dB point on the jitter transfer curve.
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Step 8
Select the SATA 50 M SJ waveform from the waveform list. On the oscilloscope, click “Single” to
run the acquisition and measurement on JIT3. Click the DATA TIE 1 measurement, and record the
measured Dj. Verify the level of modulation meets the requirements and record the p-p level (DJ t) in
the B10 cell of the JTF Calibration spreadsheet.

Next, click the “Data PLL TIE 1” in the measurement list, and record the measured Dj in the B11 cell
of the JTF Calibration spreadsheet.
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Step 9
On the AWG, select the waveform “Gen2 No Jitter”. This is used to verify the residual jitter at this
setting.
Again measure and record the Data PLL TIE 1 Dj using JIT3 in the B12 cell of JTF Calibration
spreadsheet.
This establishes the reference DJ value of excitation that is applied to the JMD. Record the measured
jitter level as the reference DJ value (DJ 0dB).
Step 10
The JTF Calibration spreadsheet then calculates the -3 dB value: DJ-3 dB = DJ 0 dB × 0.708.
Step 11
Determine the specific frequency that matches the -3 dB level found in step 10. This is done by
sequentially setting the AWG Dj frequency in a range from 1.1 MHz to 3 MHz. At each setting, the
measurement is made on the oscilloscope using the Data PLL TIE 1 measurement. Assume the
residual DJ is zero for the search (this speeds up the search).
Once the -3 dB frequency is determined, record the measured Dj at that frequency into cell B13 of the
JTF Calibration spreadsheet. Turn off the jitter modulation on the AWG by again selecting the Gen2
No Jitter waveform. Retake the measurement to get the residual, and enter this into the spreadsheet
at cell B14. Enter the -3 dB frequency in spreadsheet cell B15.
Step 12
Verify the DJ –3 dB frequency is 2.1 MHz ± 1 MHz. The typical -3 dB frequency is approximately
1.55 MHz. Repeat step 4 through step 12 until both the jitter attenuation and 3 dB frequency meet the
requirements of the specifications contained in ECN-008.
Step 13
Check the peaking of the JTF. Adjust the pattern generator for a D24.3 pattern and modulation to
produce sinusoidal phase modulation at the –3 dB frequency and 0.3 UI p-p ± 10% (200 ps for Gen1,
100 ps for Gen2). This is done on the AWG by opening the file “Sata JTF peak set.awg”. This provides
waveforms containing the prescribed amount of jitter at frequencies ranging from 3 MHz to 20 MHz.
To find the peaking of the JTF requires multiple jitter measurements which may be time consuming.
The JTF peaking is flat over a portion of the range. Start at the 3 dB frequency setting, and increment
by 1 MHz until reaching 20 MHz or the readings start to decrease. Record the maximum jitter value
and frequency. Once the peaking frequency is determined, enter the Dj value measured at that
frequency into the spreadsheet at cell B16. Again determine the residual level by turning off the
jitter on the AWG, and enter that measured residual jitter into the spreadsheet at cell B17. Enter the
peaking frequency at cell B18 of the spreadsheet.
Step 14
The spreadsheet provides a calculation of the peaking level using the formula: 20 ×
log[(DJ-peaking)/(DJ-0 dB)]

124

TekExpress Serial ATA/SAS Automated Solutions

Calibration and Verification of Jitter Measurement Devices

Detailed Procedure

Typical peaking for the Tek system is 3 MHz. The following is a completed example.

Step 15
Update the JIT3 setup files that TekExpress is using with above calculated values. Update the
following JIT3 setup files.
Test name

UTD 1.2

UTD 1.3

TSG -07 - Tj at Connector, Clock to
Data, Fbaud/10

UTD 1.2_TSG07_08Ref_HFTP-Gen
1.ini
UTD 1.2_TSG07_08Ref_LBP-Gen
1.ini

UTD 1.3_TSG07_08Ref_HFTP-Gen
1.ini
UTD 1.3_TSG07_08Ref_LBP-Gen
1.ini

UTD 1.2_TSG09_10Ref_HFTP-Gen
1.ini
UTD 1.2_TSG09_10Ref_LBP-Gen
1.ini

UTD 1.3_TSG09_10Ref_HFTP-Gen
1.ini
UTD 1.3_TSG09_10Ref_HFTP-Gen
1.ini

UTD 1.2_TSG11_12Ref_HFTP-Gen
2.ini
UTD 1.2_TSG11_12Ref_LBP-Gen
2.ini

UTD 1.3_TSG11_12Ref_HFTP-Gen
2.ini UTD 1.3_TSG11_12Ref_LBPGen 2.ini
UTD 1.3_TSG11_12Ref_LBP-Gen
2.ini

TSG -08 - Dj at Connector, Clock to
Data, Fbaud/10
TSG -09 - Tj at Connector, Clock to
Data, Fbaud/500
TSG -10 - Dj at Connector, Clock to
Data, Fbaud/500
TSG -11 - Tj at Connector, Clock to
Data, Fbaud/500
TSG -12 - Dj at Connector, Clock to
Data, Fbaud/500
xxx
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OOB-01 Level Calibration Procedure using DPOJET Application
Follow the these steps to calibrate AWG7102 using the DPOJET application:
Step 1
This procedure requires that the oscilloscope has been properly set up prior to making any
measurement. This includes a 20 minute warm-up, running SPC, applying any required external
attenuation, entering the attenuator values into the oscilloscope’s vertical setup, and performing
channel deskew. Once this is done, the oscilloscope can be connected to the SATA test fixture.
Step 2
In addition, this procedure requires that the AWG has been properly set up prior to making any
measurements. This includes a 20 minute warm-up, and running the system calibration. Once this is
complete, the AWG can be connected to the SATA test fixture.
Step 3
After the equipment has been properly set up, connect a loop-back to the SATA Near End fixture. This
loop-back consists of a SATA Far End fixture, and short SMA cables which connect the Transmitter
D+ to the Receiver D+, and the Transmitter D- to the Receiver D-. If a loop-back is not available, it
is acceptable to disconnect the SATA test fixture, and connect the Tx and Rx cables together using
SMA barrel connectors.
Step 4
On the AWG, open the “CRST02-3G210-6x.awg” file. This produces an OOB COMINIT/COMRESET
burst set that is approximately 210 mV in amplitude.
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Step 5
On the oscilloscope, launch the Jitter and Eye Analysis package (DPOJET).

Step 6
Recall the settings file “SATA OOB 210mv cal”. This will configure the oscilloscope as well as
the DPOJET settings.
Note that the SATA Logo group has defined this measurement to be made using a MODE measurement
on the .45 to .55 (center 10%) portion of the UI, and to average the MODE measurements of all of the
UI contained in all of the COMINIT bursts. It is not necessary to manually set the DPOJET settings
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after loading the settings file, but the following screen shows the settings that are created by the
“SATA OOB 210mv cal” setup file:

Step 7
Click the “Run” button, and while the measurement is running, adjust the AWG output amplitude as
close as possible to 210 mV. It might be convenient to stop the measurement, clear the previous data,
and restart the data to get a more accurate reading. If everything is configured properly, it is easy to get
better than 1% error (±2 mV) on this adjustment. The following screen shows the adjustment window:
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Step 8
The results are displayed in the following location:

Step 9
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Repeat the procedure for the 40 mV and 60 mV settings. The AWG files used to generate the signals
are “CRST02-3G040-6x.awg” and “CRST02-3G060-6x.awg”. The setup files for the oscilloscope to
make these measurements are “SATA OOB 40mv cal.set” and “SATA OOB 60mv cal.set”.

OOB-01 Calibration Procedure without using the DPOJET Application
The objective of the procedure is to add or subtract a residue voltage level from the AWG to exactly see
210 mV, 60 mV or 40 mV levels on the OOB1 stimulus captured on oscilloscope. On the AWG, open
the “CRST02-3G210-6x.awg” file. This produces an OOB COMINIT/COMRESET burst set that is
approximately 210 mV in amplitude.
NOTE. The calibration procedure without using the DPOJET application is applicable only to TDS
Oscilloscopes.
This procedure requires that the oscilloscope has been properly set up prior to making any measurements.
This includes a 20 minute warm-up, running SPC, applying any required external attenuation, entering
the attenuator values into the oscilloscope’s vertical setup, and performing channel deskew. Once this
is done, the oscilloscope can be connected to the SATA test fixture.
In addition, this procedure requires that the AWG has been properly set up prior to making any
measurements. This includes a 20 minute warm-up, and running the system calibration. Once this is
complete, the AWG can be connected to the SATA test fixture.
After the equipment has been properly set up, connect a loop-back to the SATA Near End fixture. This
loop-back consists of a SATA Far End fixture, and short SMA cables which connect the Transmitter
D+ to the Receiver D+, and the Transmitter D- to the Receiver D-. If a loop-back is not available, it is
acceptable to disconnect the SATA test fixture, and connect the Tx and Rx cables together using SMA
barrel connectors.
On the AWG, open the “CRST02-3G210-6x.awg” file. This produces an OOB COMINIT/COMRESET
burst set that is approximately 210 mV in amplitude.
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Capture the differential waveform on a TDS oscilloscope. Create a math channel from the differential
inputs and enable display of it.

To perform the calibration we need to find the amplitude of the waveform. But it is not a peak- to- peak
measurement available in measurements feature of TDS oscilloscope.
Note that the SATA Logo group has defined this measurement to be made using a MODE measurement on
the .45 to .55 (center 10%) portion of the UI, and to average the MODE measurements of all of the UI
contained in all of the COMINIT bursts.
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Save the math waveform with a name such as COMRESET_Diff.wfm

To measure MODE on these epochs, run SATAOOB.EXE utility with the saved waveform as the argument.

The Amplitude value here is 548.7/2 = 274.35 mV. The amount of AWG output level to be reduced
is 274.35 – 210 = 64.35 mV.
Take another capture from the TDS and run the SATA OOB utility on the saved waveform file. Another
delta value can be computed. Keep adding or subtracting this value on the AWG output until the measured
value on the oscilloscope with this utility comes close to 210 mV. An allowable limit is ± 1%. In the case
of 210 mV waveform it is ± 2 mV. And in the case of 40 mV waveform it is ± 0.04 mV. The following
screen shows the window for adjusting the amplitude.
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The results are displayed on the oscilloscope in the following location:
Repeat the procedure for the 40 mV and 60 mV settings. The AWG files used to generate the signals are
“CRST02-3G040-6x.awg” and “CRST02-3G060-6x.awg”. The setup files for the oscilloscope to make
these measurements are “SATAOOB 40mv cal.set” and “SATA OOB 60 mv cal.set”.

134

TekExpress Serial ATA/SAS Automated Solutions

TekExpress Programmatic Interface

About the Programmatic Interface

About the Programmatic Interface
The Programmatic interface allows you to seamlessly integrate the TekExpress test automation application
with the high-level automation layer. This also allows you to control the state of TekExpress application
running on a local or a remote computer.
For simplifying the descriptions, the following terminologies are used in this section:
TekExpress Client: A High level automation application that communicates with TekExpress using
TekExpress Programmatic Interface.
TekExpress Server: The TekExpress application when being controlled by TekExpress Client.
TekExpress leverages .Net Marshalling to enable the Programmatic Interface for TekExpress Client.
TekExpress provides a client library for TekExpress clients to use the programmatic interface. The
TekExpress client library is inherited from .Net MarshalByRef class to provide the proxy object for the
clients. The TekExpress client library maintains a reference to the TekExpress Server and this reference
allows the client to control the server state.

Click the following links to get details on them:
What does one need to have to develop TekExpress Client ?
While developing TekExpress Client one needs to use the TekExpressClient.dll. The client can be a VB
.Net, C# .Net, TestStand or web application. The examples for interfaces in each of these applications
are in Samples folder.

References required
TekExpressClient.dll has internal reference to IIdlglib.dll and IRemoteInterface.dll.
IIdlglib.dll has a reference to TekDotNetLib.dll.
IRemoteInterface.dll provides the interfaces required to perform the remote automations. It is an interface
that forms the communication line between the server and the client.
IIdlglib.dll provides the methods to generate and direct the secondary dialog messages at the client-end.
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NOTE. The end-user client application does not need any reference to above mentioned DLL files. It is
essential to have these DLLs (IRemoteInterface.dll, IIdlglib.dll and TekDotNetLib.dll) in same folder
location as that of TekExpressClient.dll.
What steps does a client need to follow ?
The following are the steps that a client needs to follow to use the TekExpressClient.dll to programmatically
control the server:
A client UI must be developed to access the interfaces exposed through the server. This client needs to
load TekExpressClient.dll to access the interfaces. Once the TekExpressClient.dll is loaded, the
client UI can call the specific functions to run the operations requested by the client. Once the client is
up and running, it must do the following to run a remote operation:
1. The client needs to provide the IP address of the PC at which the server is running in order to connect
to the server.
2. The client needs to lock the server application to avoid conflict with any other Client that may try to
control the server simultaneously. “Lock” would also disable all user controls on server so that server
state cannot be changed by manual operation.
3. If any other client tries to access a server which is locked, it will get a notification that the server
is locked by another client.
4. When the client has connected to and locked the server, the client can access any of the programmatic
controls to run the remote automations.
5. Once the client operations are completed, the server needs to be “unlocked” by the client.

Server and Client Proxy Objects
Remote Proxy Object
The server exposes a remote object to let the remote client access and perform the server side operations
remotely. The proxy object is instantiated and exposed at the server-end through marshalling.

136

TekExpress Serial ATA/SAS Automated Solutions

TekExpress Programmatic Interface

Server and Client Proxy Objects

The following is an example:
RemotingConfiguration.RegisterWellKnownServiceType (typeof (TekExpressRemoteInterface), “TekExpress Remote interface”, WellKnownObjectMode.Singleton);

This object lets the remote client access the interfaces exposed at the server side. The client gets the
reference to this object when the client gets connected to the server.
For example,
//Get a reference to the remote object
remoteObject = (IRemoteInterface)Activator.GetObject(typeof(IRemoteInterface),
URL.ToString());

Client Proxy Object
Client exposes a proxy object to receive certain information.

For example,
//Register the client proxy object
WellKnownServiceTypeEntry[] e = RemotingConfiguration.GetRegisteredWellKnownServiceTypes();
clientInterface = new ClientInterface();
RemotingConfiguration.RegisterWellKnownServiceType(typeof(ClientInterface),
“Remote Client Interface”, WellKnownObjectMode.Singleton);

//Expose the client proxy object through marshalling
RemotingServices.Marshal(clientInterface, "Remote Client Inteface");

The client proxy object is used for the following:
1. To get the secondary dialog messages from the server.
2. To get the file transfer commands from the server while transferring the report.
Click here to see examples.
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clientObject.clientIntf.DisplayDialog(caption, msg,iconType, btnType);
clientObject.clientIntf.TransferBytes(buffer, read, fileLength);

To know more on the topics below, click the links.
Secondary Dialog Message Handling

The secondary dialog messages from the Secondary Dialog library are redirected to the client-end when a
client is performing the automations at the remote end.
In the secondary dialog library, the assembly that is calling for the dialog box to be displayed is checked
and if a remote connection is detected, the messages are directed to the remote end.
File Transfer Events
When the client requests the transfer of the report, the server reads the report and transfers the file by
calling the file transfer methods at the client-end.
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Client Programmatic Interface: An Example
An example of the client programmatic interface is described and shown as follows:
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1. Connect to a server or remote object using the programmatic interface provided.
2. Get the client ID that is created when connecting to the remote object. This client ID is one of the
required parameters to communicate with the server.
NOTE. Server identifies the client with this ID only and rejects any request if the ID is invalid.
3.

Lock the server for further operations. This disables the application interface.

NOTE. You can get values from the server or set values from the server to the client only if application is
locked.
4. Register for receiving notifications on status change events on the server. To register you need to
give a handler as a parameter.
NOTE. Whenever there is a change in the status of the server, all the clients registered with the server
receive a notification from the server.
5. Select the tests that you want to run through the programmatic interface.
6. Set the necessary parameters for each test.
7. Run the tests.
8. Poll for the status of the application.
NOTE. You can skip this step if you are registered for the status change notification and when the status is
Ready.
9. After completing the tests, get the results.
10. Create a report or display the results and verify or process the results.
11. Unlock the server once you complete all the tasks.
12. Disconnect from the remote object.

Handler of Status Change Notification
1. Get the status. If the status is Wait or Error, get the information which contains the title, message
description, and the expected responses for the status.
2. Perform the actions based on the status information.
3. Set the response as expected.
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SATA Application Command Arguments and Queries
Connect through an IP address (see page 148)
Lock the server (see page 149)
Disable the popups (see page 150)
Set or get the DUT ID (see page 151)
Set the configuration parameters for a suite or measurement (see page 152)
Query the configuration parameters for a suite or measurement (see page 153)
Select a measurement (see page 155)
Select a suite (see page 156)
Run with set configurations or stop the run operation (see page 157)
Handle Error Codes (see page 167)
Get or set the timeout value (see page 158)
Wait for the test to complete (see page 158)
After the test is complete (see page 161)
Save, recall, or check if a session is saved (see page 165)
Unlock the server (see page 166)
Disconnect from server (see page 166)

string id
Name

Type

Direction

Description

id

string

IN

Identifier of the client that is
performing the remote function.

xxx

Ready: Test configured and ready to start.
Running: Test running.
Paused: Test paused.
Wait: A popup that needs your inputs.
Error: An error is occurred.
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string dutName
Name

Type

Direction

Description

dutName

string

IN

The new DUT ID of the setup.

Name

Type

Direction

Description

saved

bool

OUT

Boolean representing whether the
current session is saved.

xxx

out bool saved

xxx

This parameter is used as a check in SaveSession() and SaveSessionAs() functions.

string ipAddress
Name

Type

Direction

Description

ipAdress

string

IN

The ip address of the server to which the client
is trying to connect to. This is required to
establish the connection between the server
and the client.

xxx

out string clientID
Name

Type

Direction

Description

clientid

String

OUT

Identifier of the client that is connected to the
server.
clientId = unique number + ipaddress of the
client. For example, 1065–192.157.98.70

xxx

NOTE. If the dutName parameter is null, the client is prompted to provide a valid DUT ID.
NOTE. The server must be active and running for the client to connect to the server. Any number of
clients can be connected to the server at a time.
NOTE. When the client is disconnected, it is unlocked from the server and then disconnected. The id
is reused.
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string dutId
Name

Type

Direction

Description

dutId

string

OUT

The DUT ID of the setup.

xxx

The dutId parameter is set after the server processes the request.

string device
Name

Type

Direction

Description

device

string

IN

Specifies the name of the device.

Name

Type

Direction

Description

suite

string

IN

Specifies the name of the suite.

Name

Type

Direction

Description

test

string

IN

Specifies the name of the test to
obtain the pass or fail status.

xxx

string suite

xxx

string test

xxx

string parameterString
Name

Type

Direction

Description

parameterString

string

IN

Selects or deselects a test.

Name

Type

Direction

Description

rowNr

int

IN

Specifies the zero based row index of
the sub-measurement for obtaining
the result value.

xxx

int rowNr

xxx

NOTE. When the client tries to lock a server that is locked by another client, the client gets a
notification that the server is already locked and it must wait until the server is unlocked. If the client
locks the server and is idle for a certain amount of time then the server is unlocked automatically
from that client.
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out string[] status
Name

Type

Direction

Description

status

string array

OUT

The list of status messages generated
during run.

Type

Direction

Description

string

IN

The name of the session being
recalled.

xxx

string name
Name
name

xxx

The name parameter cannot be empty. If it is empty, the client is prompted to provide a valid name.
NOTE. When the run is performed, the status of the run is updated periodically using a timer.

string name
Name
name

Type

Direction

Description

string

IN

The name of the session being
saved.

xxx

The name parameter cannot be empty. If it is empty, the client is prompted to provide a valid name.
Once the session is saved under ‘name’ you cannot use this method to save the session in a different
name. Use SaveSessionAs instead.

string name
Name
name

Type

Direction

Description

string

IN

The name of the session being
recalled.

xxx

The same session is saved under different names using this method. The name parameter cannot be
empty. If it is empty, the client is prompted to provide a valid name.

bool isSelected
Name

Type

Direction

Description

isSelected

bool

IN

Selects or deselects a test.

xxx
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string time
Name

Type

Direction

Description

time

string

IN

The time in seconds
which refers to the timeout
period.

xxx

The time parameter gives the timeout period, that is the time the client is allowed to be locked and
idle. After the timeout period if the client is still idle, it gets unlocked.
The time parameter should be a positive integer. Else, the client is prompted to provide a valid
timeout period.

bool_verbose
Name

Type

Direction

Description

_verbose

bool

IN

Specifies whether thec verbose mode
should be turned ON or OFF.

xxx

NOTE. When the session is stopped, the client is prompted to stop the session and is stopped at
the consent.

string filePath
Name

Type

Direction

Description

filePath

string

IN

The location where the report must
be saved in the client.

xxx

NOTE. If the client does not provide the location to save the report, the report is saved at
C:\ProgramFiles.
NOTE. When the client is disconnected, the client is automatically unlocked.

out string caption
Name

Type

Direction

Description

caption

String

OUT

The wait state or error state message sent to
you.

xxx
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out string message
Name
message

Type

Direction

Description

String

OUT

The wait state /error state message to you.

xxx

out string[] buttonTexts
Name

Type

Direction

Description

buttonTexts

string array

OUT

An array of strings containing the
possible response types that you can
send.

Type

Direction

Description

string

IN

A string containing the response
type that you can select (it must be
one of the strings in the string array
buttonTexts).

xxx

string response
Name
response

xxx

out string clientID
Name

Type

Direction

Description

clientID

String

OUT

Identifier of the client that is connected to the
server.
clientID = unique number + ipaddress of the
client. For example, 1065–192.157.98.70

xxx
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Connect Through an IP Address
Table 10: Connect through an IP address
Command name

Parameters

Description

Return Value

Example

Connect()

string
ipAddress (see
page 143)
out string
clientID (see
page 143)

This method
connects the client
to the server.
Note (see
page 143)
The client provides
the IP address
to connect to the
server.
The server
provides a unique
client identification
number when
connected to it.

Return value is
either True or
False.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as boolean
returnval = m_Client.Connect(ipaddress,m_clientID)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:
The server is LOCKED and the message displayed is "Server is locked by another client".
The session is UNLOCKED and the message displayed is "Lock Session to execute the command".
The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".
When none of these fail conditions occur, then the message displayed is "Failed...".

148

TekExpress Serial ATA/SAS Automated Solutions

TekExpress Programmatic Interface

Lock the Server

Lock the Server
Table 11: Lock the server
Command name

Parameters

Description

Return Value

Example

LockSession()

string clientID
(see page 147)

This method locks
the server.
Note (see
page 144)
The client must
call this method
before running
any of the remote
automations. The
server can be
locked by only one
client.

String value that
gives the status
of the operation
after it has been
performed.
The return value
is "Session
Locked...” on
success.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval =
m_Client.LockServer(clientID)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:
The server is LOCKED and the message displayed is "Server is locked by another client".
The session is UNLOCKED and the message displayed is "Lock Session to execute the command".
The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".
When none of these fail conditions occur, then the message displayed is "Failed...".
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Disable the Popups
Table 12: Disable the popups
Command name

Parameters

Description

Return Value

Example

SetVerboseMode()

string clientID
(see page 147)
bool _verbose
(see page 146)

This method sets
the verbose mode
to either true or
false.
When the value
is set to true,
then any of the
message boxes
appearing during
the application
is routed to the
client machine
which is controlling
TekExpress.
When the value is
set to false, then
all the message
boxes will be
shown on the
server machine.

String that gives
the status of
the operation
after it has been
performed.
When Verbose
mode is set to
true, the return
value is “Verbose
mode turned on.
All dialog box are
shown to client
...”.
When Verbose
mode is set to
false, the return
value is “Verbose
mode turned off.
All dialog boxes
will be shown to
server ...”.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
Verbose mode is turned on
return=m_Client.SetVerboseMode(clientID, true)
Verbose mode is turned off
returnval=m_Client.SetVerboseMode(clientID, false)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:
The server is LOCKED and the message displayed is "Server is locked by another client".
The session is UNLOCKED and the message displayed is "Lock Session to execute the command".
The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".
When none of these fail conditions occur, then the message displayed is "Failed...".
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Set or Get the DUT ID
Table 13: Set or Get the DUT ID
Command name

Parameters

Description

Return Value

Example

SetDutId()

string clientID
(see page 147)
string dutName
(see page 143)

This method
changes the DUT
ID of the set up.
The client must
provide a valid
DUT ID.

String that gives
the status of
the operation
after it has been
performed.
Return value
is “DUT Id
Changed...” on
success.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
return=m_Client.SetDutId(clientID,desiredDutId)
Note (see page 143)

GetDutId()

string clientID
(see page 147)
string dutId (see
page 144)

This method gets
the DUT ID of the
current set up.

String that gives
the status of
the operation
after it has been
performed.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
return=m_Client.GetDutid(clientID, out DutId)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:
The server is LOCKED and the message displayed is "Server is locked by another client".
The session is UNLOCKED and the message displayed is "Lock Session to execute the command".
The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".
When none of these fail conditions occur, then the message displayed is "Failed...".
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Set the Configuration Parameters for a Suite or Measurement
Table 14: Set the configuration parameters for a suite or measurement
Command name

Parameters

Description

Return Value

Example

SetGeneralParameter()

string clientID
(see page 147)
string device
(see page 144)
string suite (see
page 144)
string test (see
page 144)
string parameterString (see
page 144)

This method
sets the general
parameters that
are not specific to
any given suite or
measurement.

String that gives
the status of
the operation
after it has been
performed.
The return
value is "" (an
empty String) on
success.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string

SetAnalyzeParameter()

string clientID
(see page 147)
string device
(see page 144)
string suite (see
page 144)
string test (see
page 144)
string parameterString (see
page 144)

This method sets
the configuration
parameters in the
Analyze panel of
the Configuration
Panel dialog box
for a given suite or
measurement.

The return
value is "" (an
empty String) on
success.

m_Client = new Client()
//m_Clientis a reference to the
Client class in the Client DLL
returnval as string

SetAcquireParameter()

string clientID
(see page 147)
string device
(see page 144)
string suite (see
page 144)
string test (see
page 144)
string parameterString (see
page 144)

This method sets
the configuration
parameters in the
Analyze panel of
the Configuration
Panel dialog box
for a given suite or
measurement.

returnVal = remoteObject.SetAcquireParameter(id, device,
suite, test, parameterString)
if ((OP_STATUS)
returnVal !=
OP_STATUS.SUCCESS) return
CommandFailed(returnVal)

m_Client = new Client()
//m_Clientis a reference to the
Client class in the Client DLL
returnval as string

NOTE. Using
this command we
can select a lane,
channel, or source
type.

xxx
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NOTE. The Fail condition for PI commands occurs in any of the following cases:
The server is LOCKED and the message displayed is "Server is locked by another client".
The session is UNLOCKED and the message displayed is "Lock Session to execute the command".
The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".
When none of these fail conditions occur, then the message displayed is "Failed...".

Query the Configuration Parameters for a Suite or Measurement
Table 15: Query the configuration parameters for a suite or measurement
Command name

Parameters

Description

Return Value

Example

GetGeneralParameter()

string clientID
(see page 147)
string device
(see page 144)
string suite (see
page 144)
string test (see
page 144)
string parameterString (see
page 144)

This method
gets the general
configuration
parameters for
a given suite or
measurement.

The return value
is the general
configuration
parameter for
a given suite or
measurement
that is set.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
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Table 15: Query the configuration parameters for a suite or measurement (cont.)
Command name

Parameters

Description

Return Value

Example

GetAnalyzeParameter()

string clientID
(see page 147)
string device
(see page 144)
string suite (see
page 144)
string test (see
page 144)
string parameterString (see
page 144)

This method gets
the configuration
parameters set
in the Analyze
panel of the
Configuration
Panel dialog box
for a given suite or
measurement.

The return
value is the
configuration
parameter set
in the Analyze
panel of the
Configuration
Panel dialog box
for a given suite
or measurement.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string

GetAcquireParameter()

string clientID
(see page 147)
string device
(see page 144)
string suite (see
page 144)
string test (see
page 144)
string parameterString (see
page 144)

This method gets
the configuration
parameters set in
the Acquire panel
for a given suite or
measurement.

The return
value is the
configuration
parameter set in
the Acquire panel
for a given suite
or measurement.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:
The server is LOCKED and the message displayed is "Server is locked by another client".
The session is UNLOCKED and the message displayed is "Lock Session to execute the command".
The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".
When none of these fail conditions occur, then the message displayed is "Failed...".
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Select a Measurement
Table 16: Select a measurement
Command name

Parameters

Description

Return Value

Example

SelectTest()

string clientID
(see page 147)
string device
(see page 144)
string suite (see
page 144)
string test (see
page 144)
bool isSelected
(see page 145)

This method
selects or
deselects a given
test.
Setting parameter
isSelected to true,
you can select a
measurement.
Setting parameter
isSelected to false,
you can deselect a
measurement.

String that
displays the
status of the
operation after
it has been
performed.
The return
value is "" (an
empty String) on
success.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
Select Measurement (OOB1):
returnval=m_Client.SelectTest(clientID, "Device",
"Suite", "OOB", true)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:
The server is LOCKED and the message displayed is "Server is locked by another client".
The session is UNLOCKED and the message displayed is "Lock Session to execute the command".
The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".
When none of these fail conditions occur, then the message displayed is "Failed...".
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Table 17: Select a suite
Command name

Parameters

Description

Return Value

Example

SelectSuite()

string clientID
(see page 147)
string device
(see page 144)
string suite
(see page 144)
bool isSelected
(see page 145)

This method
selects or
deselects a given
suite.
Setting parameter
isSelected to true,
you can select a
suite.
Setting parameter
isSelected to false,
you can deselect a
suite.

String that gives
the status of
the operation
after it has been
performed.
The return
value is "" (an
empty String) on
success.

m_Client = new Client()
//m_Client is a reference to
the Client class in the Client DLL
returnval as string
Select Suite (Default):
returnval=m_Client.SelectSuite(clientID, "Device", "Suite",
true)
Select Calibration Suite:
returnval=mClient.SelectTest(clientID, "Device", "Drive", true)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:
The server is LOCKED and the message displayed is "Server is locked by another client".
The session is UNLOCKED and the message displayed is "Lock Session to execute the command".
The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".
When none of these fail conditions occur, then the message displayed is "Failed...".
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Run with Set Configurations or Stop the Run Operation
Table 18: Run with set configurations or Stop the run operation
Command name

Parameters

Description

Return Value

Example

Run()

string clientID
(see page 147)

Runs the selected
measurements.
Note (see
page 145)
Once the server
is set up and is
configured, it can
be run remotely
using this function.

String that gives
the status of
the operation
after it has been
performed.
The return value
is "Run started..."
on success.

m_Client = new Client()
//m_Clientis a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.Run(clientID)

Stop()

string clientID
(see page 147)

Stops the
currently running
measurements.
Note (see
page 146)

String that gives
the status of
the operation
after it has been
performed.
The return value
is "Stopped..." on
success.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.Stop(clientID)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:
The server is LOCKED and the message displayed is "Server is locked by another client".
The session is UNLOCKED and the message displayed is "Lock Session to execute the command".
The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".
When none of these fail conditions occur, then the message displayed is "Failed...".
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Get or Set the Timeout Value
Table 19: Get or Set the Timeout value
Command name

Parameters

Description

Return Value

Example

GetTimeOut()

string clientID
(see page 147)

Returns the current
timeout period set
by the client.

String that gives
the status of
the operation
after it has been
performed.
The default
return value is
1800000.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.GetTimeOut()

SetTimeOut()

string clientID
(see page 147)
string time (see
page 146)

Sets a timeout
period specified by
client. After expiry
of this timeout
period, the server
is automatically
unlocked.

String that gives
the status of
the operation
after it has been
performed.
On success the
return value is
“TimeOut Period
Changed”.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.SetTimeOut(clientID, desiredTimeOut)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:
The server is LOCKED and the message displayed is "Server is locked by another client".
The session is UNLOCKED and the message displayed is "Lock Session to execute the command".
The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".
When none of these fail conditions occur, then the message displayed is "Failed...".

Wait for the Test to Complete
The commands in this group are executed while tests are running. The GetCurrentStateInfo() and
SendResponse() commands are executed when application is running and in wait state.

158

TekExpress Serial ATA/SAS Automated Solutions

TekExpress Programmatic Interface

Wait for the Test to Complete

Table 20: Wait for the test to complete
Command name

Parameters

Description

Return Value

Example

ApplicationStatus()

string clientID
(see page 147)

This method gets the
status of the server
application.
The states at a given
time are Ready,
Running, Paused,
Wait, or Error. (see
page 142)

String value that
gives the status
of the server
application.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.ApplicationStatus(clientID)

QueryStatus()

string clientID
(see page 147)
out string[]
status (see
page 145)

It is an interface for
the user to transfer
Analyze panel status
messages from the
server to the client.

String that gives
the status of
the operation
after it has been
performed.
On success the
return value is
“Transferred...”.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnVal=m_Client.QueryStatus(clientID, out statusMessages)
if ((OP_STATUS)returnVal ==
OP_STATUS.SUCCESS)
return “Status updated...”
else
return CommandFailed(returnVal)
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Table 20: Wait for the test to complete (cont.)
Command name

Parameters

Description

Return Value

Example

GetCurrentStateInfo()

string clientID
(see page 147)
out string
caption (see
page 146)
out string
message (see
page 147)
out string[]
buttonTexts
(see page 147)

This method gets
the additional
information of the
states when the
application is in Wait
or Error state.
Except client ID, all
the others are out
parameters.

This command
does not return
any value.
This function
fills up the out
parameters that
are passed
when invoking
this function.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
m_Client.GetCurrentStateInfo(
clientID, caption,message,
buttonTexts (see page 161))

string clientID
(see page 147)
out string
caption (see
page 146)
out string
message (see
page 147)
string response
(see page 147)

After receiving the
additional information using the method
GetCurrentStateInfo(), the client can
decide on the response to send and
send the response
to the application using this function.The
response should be
one of the strings that
was earlier received
as a string array in
the GetCurrentStateInfo function.The
_caption and _message should match
the information received earlier in the
GetCurrentStateInfo
function.

This command
does not return
any value.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
m_Client.SendResponse(
clientID, caption,message,
response (see page 161))

NOTE. This
command is
used when the
application is
running and is in
the wait or error
state.

SendResponse()

NOTE. This
command is
used when the
application is
running and is in
the wait or error
state.

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:
The server is LOCKED and the message displayed is "Server is locked by another client".
The session is UNLOCKED and the message displayed is "Lock Session to execute the command".
The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".
When none of these fail conditions occur, then the message displayed is "Failed...".
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After the Test is Complete
Table 21: After the test is complete
Command name

Parameters

Description

Return Value

Example

GetPassFailStatus()

string clientID
(see page 147)
string device
(see page 144)
string suite (see
page 144)
string test (see
page 144)

This method gets
the pass or fail
status of the
measurement after
test completion.

String that gives
the status of
the operation
after it has been
performed.
Returns the pass
or fail status in
the form of a
string.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.GetPassFailStatus(clientID, device,
suite, ”OOB1”) //Pass or Fail

NOTE. Execute
this command
after completing
the measurement.
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Table 21: After the test is complete (cont.)
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Command name

Parameters

Description

Return Value

Example

GetResultsValue()

string clientID
(see page 147)
string device
(see page 144)
string suite (see
page 144)
string test (see
page 144)
string parameterString (see
page 144)

This method gets
the result values of
the measurement
after the run.

String that gives
the status of
the operation
after it has been
performed.
Returns the
result value in
the form of a
string.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as srting
returnval=m_Client.GetResultsValue(clientID, "Device",
"Suite", "OOB1", "Results")

GetResultsValueForSubMeasurements()

string clientID
(see page 147)
string device
(see page 144)
string suite (see
page 144)
string test (see
page 144)
string parameterString (see
page 144)
int rowNr (see
page 144)

This method gets
the result values
for individual submeasurements,
after the run.

String that gives
the status of
the operation
after it has been
performed.
Returns the
result value in
the form of a
string.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
OOB1
returnval=m_Client.GetResultsValueForSubMeasurements(clientID, "Device",
"Suite", "OOB1", "Results",0)

GetReportParameter()

string clientID
(see page 147)
string device
(see page 144)
string suite (see
page 144)
string test (see
page 144)
string parameterString (see
page 164)

This method
gets the general
report details such
as oscilloscope
model, TekExpress
version, and SATA
version.

The return
value is the
oscilloscope
model,
TekExpress
version, and
SATA version.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
Oscilloscope Model
returnval=m_Client.GetReportParameter(clientID,"Scope
Model")
TekExpress Version
returnval=m_Client.GetReportParameter(clientID,"TekExpress
Version")
SATA Version
returnval=m_Client.GetReportParameter(clientID," SATA
Version")
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Table 21: After the test is complete (cont.)
Command name

Parameters

Description

Return Value

Example

TransferReport()

string clientID
(see page 147)
string filePath
(see page 146)

This method
transfers the report
generated after the
run.
The report
contains the
summary of the
run.
The client must
provide the
location where
the report is to
be saved at the
client-end.

String that gives
the status of
the operation
after it has been
performed.
Transfers all the
result values in
the form of a
string.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.TransferReport(clientID,"C:\Report”)

TransferWaveforms()

string clientID
(see page 147)
string filePath
(see page 146)

This method
transfers all the
waveforms from
the folder for the
current run.

String that gives
the status of
the operation
after it has been
performed.
Transfers all the
waveforms in the
form of a string.
On success the
return value is
“Transferred...”.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.TransferWaveforms(clientID,"C:\Waveforms”)

String that gives
the status of
the operation
after it has been
performed.
Transfers all the
images in the
form of a string.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.TransferImages(clientID, "C:\Waveforms”)

NOTE. For each
click of Run
button, a folder
is created in the X:
drive. Transfer the
waveforms before
clicking the Run
button.
TransferImages()

string clientID
(see page 147)
od
string filePath
(see page 146)

This method
transfers all
the images
(screenshots) from
the folder for the
current run (for
a given suite or
measurement).

NOTE. For each
click of Run
button, a folder
is created in the X:
drive. Transfer the
waveforms before
clicking the Run
button.
xxx
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NOTE. The Fail condition for PI commands occurs in any of the following cases:
The server is LOCKED and the message displayed is "Server is locked by another client".
The session is UNLOCKED and the message displayed is "Lock Session to execute the command".
The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".
When none of these fail conditions occur, then the message displayed is "Failed...".

string parameterString
Name

Type

Direction

Description

parameterString

string

IN

Specifies the oscilloscope model,
TekExpress version, and SATA
version.

xxx
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Save, Recall, or Check if a Session is Saved
Table 22: Save, Recall, or Check if a session is saved
Command name

Parameters

Description

Return Value

Example

CheckSessionSaved()

string clientID
(see page 147)
out bool saved
(see page 143)

This method is
called when a
check is to be
made to know if
the current session
is saved.

Return value is
either True or
False.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.CheckSessionSaved(m_clientID, out
savedStatus)

RecallSession()

string clientID
(see page 147)
string name
(see page 145)

Recalls a saved
session. The
name of the
session is provided
by the client.

String that gives
the status of
the operation
after it has been
performed.
The return value
is “Session
Recalled...”.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.RecallSession(clientID, savedSessionName)

SaveSession()

string clientID
(see page 147)
string name
(see page 145)

Saves the current
session. The
name of the
session is provided
by the client.

String that gives
the status of
the operation
after it has been
performed.
The return value
is "Session
Saved..."/"Failed...".

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.SaveSession(clientID, desiredSessionName)

SaveSessionAs()

string clientID
(see page 147)
string name
(see page 145)

Saves the current
session in a
different name
every time this
method is called.
The name of the
session is provided
by the client.

String that gives
the status of
the operation
after it has been
performed.
The return value
is "Session
Saved...".

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.SaveSessionAs(clientID, desiredSessionName)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:
The server is LOCKED and the message displayed is "Server is locked by another client".
The session is UNLOCKED and the message displayed is "Lock Session to execute the command".
The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".
When none of these fail conditions occur, then the message displayed is "Failed...".
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Unlock the Server
Table 23: Unlock the server
Command name

Parameters

Description

Return Value

Example

UnlockSession()

string clientID
(see page 147)

This method
unlocks the server
from the client.
The ID of the client
to be unlocked
must be provided.
Note (see
page 146)

String that gives
the status of
the operation
after it has been
performed.
The return value
is "Session
Un-Locked...".

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.UnlockServer(clientID)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:
The server is LOCKED and the message displayed is "Server is locked by another client".
The session is UNLOCKED and the message displayed is "Lock Session to execute the command".
The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".
When none of these fail conditions occur, then the message displayed is "Failed...".

Disconnect from the Server
Table 24: Disconnect from the server
Command name

Parameters

Description

Return Value

Example

Disconnect()

string clientID
(see page 147)

This method
disconnects
the client from
the server it is
connected to.
Note (see
page 143)

Integer value that
gives the status
of the operation
after it has been
performed.
1 for Success
–1 for Failure

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.Disconnect(m_clientID)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:
The server is LOCKED and the message displayed is "Server is locked by another client".
The session is UNLOCKED and the message displayed is "Lock Session to execute the command".
The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".
When none of these fail conditions occur, then the message displayed is "Failed...".
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Handle Error Codes
The return value of the remote automations at the server-end is OP_STATUS which is changed to a string
value depending on its code and returned to the client. The values of OP_STATUS are as follows:
Value

Code

Description

FAIL

−1

The operation failed.

SUCCESS

1

The operation succeeded.

NOTFOUND

2

Server not found

LOCKED

3

The server is locked by another client, so operation cannot
be performed.

UNLOCK

4

The server is not locked. Lock the server before performing
the operation.

NULL

0

Nothing

xxx

Program Example
This is a reference program to illustrate how to communicate to TekExpress -10GBASE-T remotely.
A typical application does the following:
1. Start the application.
2. Connect through an IP address.
m_Client.Connect("localhost") ’True or False
clientID = m_Client.getClientID

3. Lock the server.
m_Client.LockServer(clientID)

4. Disable the Popups.
m_Client.SetVerboseMode(clientID, false)

5. Set the Dut ID.
m_Client.SetDutId(clientID, "DUT_Name")

6. Select a source type.
mClient.SetGeneralParameter(clientID, "Device", "Suite", "OOB1",
"PHY-TSG-OOB") ’OOB1 measurement selected

7. Select a measurement.
mClient.SelectTest(clientID, "Device", "Suite", "Droop", true) ’Droop

measurement selected
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8. Run with set configurations.
m_Client.Run(clientID)

9. Wait for the test to complete.
Do
Thread.Sleep(500)
m_Client.Application_Status(clientID)
Select Case status
Case "Wait"

’Get the Current State Information
mClient.GetCurrentStateInfo(clientID, WaitingMsbBxCaption, WaitingMsbBxMessage, WaitingMsbBxButtontexts)

’Send the Response
mClient.SendResponse(clientID, WaitingMsbBxCaption, WaitingMsbBxMessage,
WaitingMsbBxResponse)
End Select
Loop Until status = "Ready"

10. After the Test is Complete.
’Save all results values from folder for current run
m_Client.TransferResult(clientID, logDirname)

’Save all waveforms from folder for current run
m_Client.TransferWaveforms(clientID, logDirname)

’Save all images from folder for current run
m_Client.TransferImages(clientID, logDirname)

11. Unlock the server.
m_Client.UnlockServer(clientID)

12. Disconnect from server.
m_Client.Disconnect()

13. Exit the application.
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NI TestStand Client Example
The following is an example for NI TestStand Client available in the path, C:\Program
Files\Tektronix\TekExpress\TekExpress Serial SATA\Examples\Programmatic
Interface\TestStand
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Instrument Connectivity

Instrument Connectivity
If the instrument(s) are displayed in TekVISA Instrument Manager but not in the TekExpress Instrument
Bench, check the following:
Only those instruments that respond to *idn? and *opt? queries successfully, are displayed in
Instrument Bench.
Ensure that VXI-11 Server is running on the instruments.
If Instrument initialization fails during test sequence execution, do the following:
It is observed that GPIB communication with instrument over Tek-VISA layer is not initialized if in
TekVISA Instrument manager the search criteria is turned-off even if valid instrument is connected in the
network. It is necessary to turn ON the respective search criteria by opening the TekVISA Instrument
manager.

User Interface
The Acquire tab is disabled.
For a selected test suite, the test is performed on a live acquisition. If test(s) such as PHY-TSG-OOB can
be performed on pre-acquired waveforms, this tab is active.
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TestStand Run time Engine Installation
Managing multiple versions of TestStand installed on the system.
TekExpress installs TestStand version 3.5 runtime engine. If you have versions other than 3.5, while
working with TekExpress, ensure that the version shipped with TekExpress is active. You can do so by
clicking Start > Programs > National Instruments > TestStand 3.5 > TestStand Version Selector.

Test Limit is Single Sided
The test limit is single sided but report shows second value and value is shown as 0.
If the test limits are single sided for limits such as GT(>) Greater than, LT(<) Less than; then the second
value is by default 0 and is ignored by test automation script. In such cases, while analyzing the report the
second value should be ignored.
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Report shows as NAN

Report shows as NAN
Some of the result values in the report are shown as NAN.
NAN is IEEE definition for “Not a Number”. The possible causes are as follows:
The captured pattern (HFTP, MFTP, LFTP, LBP waveform files) for the analysis does not contain
a valid pattern.
The NAN value is commonly seen in TSG measurements when LFTP pattern is required for analysis
but the captured pattern is not true LFTP.
The NAN value can be seen in the final reports if a test algorithm does not successfully evaluate a
result due to one or more reasons listed above.
For trouble shooting, you can analyze the captured waveform using pattern analyzer utility which is
available in TekExpress\ACP folder. The patternAnalyzer.exe need to be run from MS DOS
prompt and takes the following command line argument:
patternAnalyzer.exe <InterfaceSpeed> <WaveformFile> <OutputTXTfile> where,
InterfaceSpeed should be specified as either Gen1 or Gen2.
Waveform file is complete waveform file path.
OutputTXTfile is output text file path.

For example, patternAnalyzer.exe “Gen2” “X:\Serial ATA\SavedSession\DUT001\20080206_185914\BISTL_HFTP_G2_Drive_DW2_Diff.wfm” “X:\results.txt”.
Open the contents of X:\results.txt to see the results.
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Instrument Connectivity using GPIB Cable
The following schematic illustrates the GPIB connectivity of instruments when TekExpress is running on a
stand-alone computer.

The following schematic illustrates the GPIB connectivity of instrument when TekExpress is running on
an oscilloscope.

Shortcut Keys
The following table lists the short cut keys to access the application:
Table 25: Keyboard short cut keys
Menu

Shortcut keys

File

Alt + F

New Session

Ctrl + N

Open Session...

Ctrl + O

Save Session...

Ctrl + S

Save Session As

Alt + F + A

Save Report As...

Alt + F + R

TekExpress Serial ATA/SAS Automated Solutions

175

Reference

Error Codes for TekExpress

Table 25: Keyboard short cut keys (cont.)
Menu

Shortcut keys

Print Preview Report

Alt + F + V

Print Report...

Ctrl + P

Recent Sessions

Alt + F + E

Exit

Ctrl + X

View

Alt + V

Log File

Ctrl + L

Tools

Alt + T

Instrument Bench...

Ctrl + I

Debug-Deskew Utility

Alt + T + D

Help

Alt + H

TekExpress Help (F1)

Alt + H + H

About...

Alt + H + A

xxx

Error Codes for TekExpress
The following table lists the error codes for the application. Most of the errors require that you restart
the system.
Table 26: Error codes and description
Error code

Description

<10000

TestStand generated error.

10001 - 11000 – Data Manager related errors
10001

Insufficient Data. The Record could not be inserted. The following
fields are empty or have insufficient data.

10002

Could not retrieve the record. The specified index is not valid.

11001 - 14000 – ICP related errors

176

11001

Operation mode is not set as specified.

11002

SetUp file Error: Specified SetUp file is not set.

11003

Operation state is not set as specified.

11004

Specified waveform is not loaded into channel memory.

11005

Specified channel is not enabled.

11006

Interleave State could not be set to off.

11007

AWG Memory Import Error. Could not import the specified
waveform into AWG memory. Filename not found.

11008

AWG Waveform Editing Error: Could not insert the specified pattern
into the AWG sequence.

12001

Operation State is not set to required value.
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Table 26: Error codes and description (cont.)
Error code

Description

12002

Display state is not set to required value.

12003

Horizontal Scale is not set to required value.

12004

Vertical scale is not set to required value.

12005

Vertical Position is not set to required value.

12006

Deskew is not set to specified value.

12007

Out of Range Error-RunTime Error Message.

13001

Acquisition timed out

13002

Channel deskew failed

13003

"Recall setup failed. Setup file not present in the specified location
<File Path>

13004

Recall setup Failed - OperationTimed out

13005

Suspecting module failure\nFollowing channels does not have the
required Peak-To-Peak value when TDR is generated\

13006

Please swap Module 1 with Module <N>

14001 - 18000 – SCP related errors
14001

Timeout Error: Application could not be activated.

14002

JIT3 Application is already running.

14003

Cannot activate JIT3 application. Some other application is running
on oscilloscope.

14004

Error recalling the specified setup.

14005

Error setting the specified Sequencer State.

14006

Error in closing the Application.

14007

Error loading the default setup.

15001 – 15006 – Iconnect Errors
15001

Z-Line function failed\nOutput file not created

15002

S-Parameter function failed\nOutput file not created

15003

Eye measurement function failed\nOutput file not created

15004

Filter function failed\nOutput file not created

15005

IConnect not installed

15006

Input waveform not present in the specified location

20001 – 25000 — Framework related codes
20001

Code for UI message passed from TestStand to Framework

20002

Code for UI message passed from TestStand to Framework

20003

Code for UI message passed from TestStand to Framework

20004

Code for UI message passed from TestStand to Framework

20005

Code for displaying dialog box passed from TestStand to Framework

20006

Code for displaying input box passed from TestStand to Framework
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Table 26: Error codes and description (cont.)
Error code

Description

20007

Code for calling exception handler passed from TestStand to
Framework

20008

Code for calling image box passed from TestStand to Framework

20009

Code for getting the pass/fail status in the analyze panel passed
from TestStand to Framework

20010

Code for getting the prerecorded waveforms path passed from
TestStand to Framework

20011

Code for displaying input dialog box passed from TestStand to
Framework

20012

Code for getting the foot note passed from TestStand to Framework

25001 - 27000 - Other Errors
25001

Analyze operation failed\n\nIConnect could not process the input
waveforms or\nIt generates output waveforms that cannot be
processed further\nCheck your configuration parameters

25002

LabVIEW Adapter configuration failed

xxx
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RecallSession(), 165
Receiver margin test
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Select Scan Parameter
Prese, 92
Receiver margin test methods, 91
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NAN, 173
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Run(), 157

S
Safety Summary, v
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SSC, 117
Starting the Application, 18
Stop(), 157
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T
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TekVISA Instrument Manager, 31
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Test Fixture, 5
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Test Parameters, 30
Test Related Files, 40
Test Suite, 28
Test suite waveforms, 35
Test(s)
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Report, 39
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TestStand Client example, 169
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